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IMPORTANT NOTICE
DISCLAIMER OF WARRANTY

Epson America makes no representations or warranties, either express
or implied, by or with respect to anything in this manual, and shall not
be liable for any implied warranties of merchantability and fitness for a
particular purpose or for any indirect, special, or consequential
damages. Some states do not allow the exclusion of incidental or
consequential damages, so this exclusion may not apply to you.

COPYRIGHT NOTICE

All rights reserved. No part of this publication may be reproduced,
stored in a retrieval system, or transmitted, in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Epson America, Inc. No patent
liability is assumed with respect to the use of information contained
herein. Nor is any liability assumed for damages resulting from the use
of the information contained herein. Further, this publication and
features described herein are subject to change without notice.

TRADEMARKS
EPSON is a registered trademark of SEIKO EPSON CORPORATION

PhotoPC 500, PhotoPix, PhotoSpan, EPSON Stylus, EPSON PhotoPC 500
imaging software, and EPSON Photo! TWAIN are trademarks of Epson
Americaq, Inc.

General notice: Other product names used herein are for identification
purposes only and may be trademarks of their respective owners.
EPSON disclaims any and all rights in those marks.

Copyright © 1996 by Epson America, Inc. CPD 4185
Torrance, California, USA 11/96

A NOTE CONCERNING RESPONSIBLE USE OF
COPYRIGHTED MATERIALS

Like photocopiers, digital cameras can be misused by improper
photographing of copyrighted material. Although Section 107 of the U.S.
Copyright Act of 1976 (Title 17, United States Code), the “fair use”
doctrine, permits limited copying in certain circumstances, those
circumstances may not be as broad as some people assume. Unless you
have the advice of a knowledgeable attorney, be responsible and
respectful by not photographing published material without the
permission of the copyright holder.



E\ Introduction

Y our new EPSON® PhotoPC 500™ is an advanced,
easy-to-use digital camera that captures clear and
attractive images. PhotoPC 500 comes with everything you
need to quickly load your photos into the computer and
then transform them into great-looking pictures to place in
your documents. Here are just a few of the things you can
do with your new, versatile camera:

[ Add color and visual appeal to your newsletters, flyers,
and brochures.
[J  Use your pictures in slide show presentations.

[J Make photo calendars and greeting cards for work and
for play.

[J  Use the optional EPSON PhotoPix™ LCD Monitor to
display images you have captured.
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PhotoPC 500 Features

PhotoPC 500 is a complete system for capturing digital

images, and includes the following features:

O

u
u

Base unit with ZMB internal flash memory that holds
up to 30 high-resolution or 60 standard-resolution
images

24-bit color image capture

Built-in flash with auto, manual, and red-eye reduction

settings
Self-timer
Automatic shut-off to save batteries

Cable for transferring photos to your computer

Your camera comes with the PhotoPC 500 Software pack,

which includes the following useful applications:

0

EPSON PhotoPC 500 Imaging Software for
downloading, organizing, editing, and enhancing your
pictures

The EPSON Photo!™ TW AIN and Utility Driver for
transferring your pictures to the computer and

changing the settings on the camera
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O

Sierra® Print Artist™ for creating calendars, banners,

and other cool projects.

The Optional EPSON PhotoPix LCD Monitor
An exciting accessory to use with your PhotoPC 500 is the

EPSON PhotoPix LCD Monitor. It offers the following

advanced features:

O O o o o o g

Playback of all the pictures stored in the camera
Close-up picture mode

Selectable image erasing

Brightness adjustment for outdoor use

Slide show of all your pictures

Multi mode for viewing several images at once

Real Time live preview so you can see the exact picture

before you snap the shutter

For more information about the EPSON PhotoPix LCD
Monitor, see Chapter 11.



Other Optional Accessories
EPSON also offers these accessories for the PhotoPC 500:

[J  2MB and 4MB PhotoSpan™ memory modules for
expanding the storage capacity of your PhotoPC 500
[0 AC adapter for use with any electrical outlet

You can also use standard 37 mm video camcorder lenses
and filters available from leading suppliers, such as Tiffen®

Manufacturing Corp.

Minimum System Requirements

To transfer images to your computer and edit them, make
sure your system meets these minimum requirements:
IBM"-compatible PC with 486 or higher processor
Serial port with standard RS-232C interface

VGA viewing screen with at least 256-color display

o 0o o od

8MB RAM (with Windows NT™, at least 16MB is
required)

O

At least 25MB free hard disk space
O Mouse or other pointing device

0 CD-ROM drive

[J  Microsoft” Windows" 3.1, Windows for Workgroups™
311 (or later), Windows 95 (or later), Windows NT

version 3.5 (or later)

Where to Get Help

EPSON provides customer support and service through a
network of authorized EPSON Customer Care Centers. Dial
(800) 922-8911 for the nearest location or for the following

services:

[ Fax-on-demand access to EPSON’s technical
information library

O Literature on current and new products

[ The location of your nearest Authorized EPSON
Reseller or Customer Care Center

[0 Technical information on installation, configuration,

and operation of EPSON products
[J Customer relations.

For answers to commonly asked questions about EPSON
products 24 hours a day, 7 days a week, call EPSON Sound
Advice at (800) 442-2110
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You can purchase manuals, accessories, or parts from
EPSON Accessories at (800) 873-7766 (U S. sales only).
In Canada, please call (800) 463-7766 for dealer referral.

If you need help using software with an EPSON product, see
the documentation for that program for technical support

information.

Electronic Support Services
You can access helpful tips, specifications, DIP switch or
jumper settings, drivers, FAQs, sample files, application

notes, and EPSON product bulletins 24 hours a day,7 daysa

week, using a modem and one of the on line services below.

World Wide Web
From the Internet, you can reach EPSON’s home page at

http://www.epson.com.

EPSON Internet FTP Site

If you have Internet FTP capability, use your Web browser
(or other software for FTP downloading) to log onto
ftp.epson.com with the user name anonymous and your

e-mail address as the password.
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EPSON Download Service

You can call the EPSON Download Service BBS at

(800) 442-2007. Set your communications software to

8 data bits, 1 stop bit, no parity. Modem speed can be up to
28.8 Kbps.

EPSON Fax-on-Demand Service

You can access EPSON'’s technical information library by
calling (800) 442-2110 or (800) 922-8911 and selecting the
appropriate phone option. You must provide a return fax

number to use Fax-on-Demand.

EPSON Forum on CompuServe®

Members of CompuServe can type GO EPSON at the menu
prompt to reach CompuServe’s Epson America Forum. As
an owner of an EPSON product, you are eligible for a free
introductory CompuServe membership, which entitles you
to an introductory credit and your own user ID and
password. To take advantage of this offer in the US. or
Canada, call (800) 848-8199 and ask for representative
#529.



Registration

Please take a minute to fill out the registration card for the
PhotoPC 500 digital camera and mail it back to us. This
enables you to receive special information on accessories,
new products, and software upgrades. You'll get immediate

attention if you have a problem with your PhotoPC 500.

Software Support

If you've tried the on-screen help and you still have
questions, call the number for the application you need
help with:

0 EPSON Photo! TWAIN driver (800) 822-8911
(800) 822-8911

(206) 644-4343

[0  PhotoPC 500 imaging software
[J  Sierra Print Artist

See the inside back cover for information about additional

support services for your software.

Safety Instructions
Read all of these instructions and save them for later
reference. Also follow all warnings and instructions

marked on the camera.

To reduce the risk of electric shock, do not remove the
camera’s cover or open any of the compartments

except as instructed in this User’s Guide.
Do not insert objects through any openings.

To prevent fire or electric shock, do not expose the

camera to rain or moisture.

To prevent fire or explosion, do not use the camera

where inflammable or volatile gas is stored.
Do not use outdoors during a thunderstorm.

If the camera shows unusual signs such as noise, odor,
or smoke, turn it off immediately. Remove the batteries
and/or disconnect the AC adapter, and unplug the AC
adapter from the electrical outlet.

Do not use harsh or abrasive cleaners. Wipe off dust

with a clean, dry cloth.

To avoid damage to the optics of the camera, do not
expose the lens to direct sunlight for extended periods
of time.

To prevent possible eye injury, do not take flash

pictures of faces at close range.
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[J Do not store the camera or its optional accessories near
sources of bright light, direct sunlight, high humidity,
heat, excessive dirt or dust, or where they will be

exposed to strong vibrations or magnetic fields.

[J Avoid sudden temperature changes, which can cause
moisture to condense on the camera. Keep the camera
in a case or bag if you need to move it from a cold
environment to a warm one. Allow time for the
camera and its optional accessories to adjust to

temperature changes before using them.

[J  Use only the types of power sources listed in this User’s
Guide.

0 Do not use a frayed or damaged power cord.

O If you use an extension cord with the optional AC
adapter, make sure the total ampere rating of the
devices plugged into the extension cord does not
exceed the cord’s ampere rating. Also, make sure the
total of all devices plugged into the wall outlet does not

exceed 15 amperes.

[0 Remove batteries and/or unplug the camera and the
AC adapter and refer servicing to qualified service

personnel under the following conditions: If the power
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cord or plug is damaged; if liquid has entered the
camera; if the camera has been dropped or its exterior
has been damaged; if the camera or its optional
accessories do not operate normally or exhibit a

distinct change in performance.

Adjust only those controls that are covered by the

operating instructions.

If the liquid crystal solution contained in the camera’s
control panel or in the screen on the optional EPSON
photo LCD Monitor leaks out and gets on your hands,
wash them thoroughly with soap and water. If it gets

in your eyes, flush them immediately with water.

If you plan to use the camera and its optional accessories in

Germany, observe the following:

0

To provide adequate short-circuit protection and over-
current protection for the products, the building
installation must be protected by a 16 amp circuit
breaker.

Bei Anschluf} des Produkts an die Stromversorgung
muf sichergestellt werden, daf’ die Gebadeinstallation

mit einem 16 A-Uberstromschalter abgesichert ist.



‘E_\ Getting Started

I his chapter helps you get ready to use your new
PhotoPC 500. It covers the following:

Unpacking your PhotoPC 500

camera

W

handstrap

Getting to know the camera
Removing the plastic film
Installing the batteries

Attaching the hand strap

O O o o o od

Installing your PhotoPC 500 software

Unpacking Your PhotoPC 500

The PhotoPC 500 includes all the parts shown to the left.
You will need everything but the Mac adapter cable. If you
purchased the EPSON PhotoPix LCD Monitor, see page 11-2

for instructions on unpacking it.

PhotoPC 500
software
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Getting to Know the Camera
After you unpack your PhotoPC 500, take a few minutes to

get to know its features.

viewfinder

timer light

memory
cover

memory
cover lock

power switch

front view
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shutter
button

green ready red Standby
control panel

light light

hand strap
holder

back view

tripod screw battery cover

opening

port cover

battery cover
lock

bottom view




Removing the Plastic Film
To protect the camera from scratches, some parts have
been covered with plastic film, as shown in the gray areas

below. Peel off the plastic film before you use your camera.

plastic film

plastic film

plastic film
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Installing Batteries

Your PhotoPC 500 comes with four AA alkaline batteries.
Make sure the camera is turned off, and follow these steps

to insert the batteries:

1 Using a fingernail or a small screwdriver, slide the
battery cover lock in the direction of the arrow and

hold it in that position while lifting up the battery

cover door.
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battery cover

battery cover
lock

2

battery compartment

Insert all four batteries into the compartment,
positioning the + and - ends as marked in the

compartment and shown in the following illustration.



3 Close the battery cover, making sure that it snaps in

place.

Handling Batteries

When your PhotoPC 500 batteries wear out, you can

replace them with any of the following:

U
U

Single-use AA alkaline batteries

Single-use AA lithium batteries (longest life)

u
u

Rechargeable AA Ni-Cad batteries
Rechargeable AA Ni-MH batteries

If you have the optional PhotoPix LCD Monitor, we

recommend that you use lithium or rechargeable batteries.

Alkaline batteries have a shorter life when used with the

monitor.

WARNING

To avoid the danger of fire or explosion, do not mix different types

of batteries. Do not allow the battery contacts to touch metal

objects such as coins or keys, which could short out the battery’s

circuits.

Note the following when handling batteries:

u
U

Do not use manganese batteries.
Replace all four batteries at the same time

Do not drop, puncture, disassemble, or mutilate

batteries. Do not get them wet or expose them to fire.

When the camera is not used for long periods of time,
remove the batteries and store them at a low

temperature in a dry location.
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0 Dispose of used batteries according to the battery Attaching the Hand Strap

manufacturer’s instructions and in compliance with To attach the hand strap, loop the strap around the holder

all applicable laws. Contact your local government on the side of the camera as shown below.

agency for information about battery recycling and

disposal. memory

module cover

O If you use rechargeable Ni-Cad or Ni-MH batteries, (back piece)

replace them with four fully charged batteries. If you hand strap

holder
find that your batteries run out faster after you
recharge them a few times, make sure you discharge

them completely before recharging.

1-6 Getting Started



|n5ta||ing Your PhotoPC 500 Software 5 Make sure PhotoPC 500 is checked, along with the

The PhotoPC 500 comes with everything you need to EPSON Photo! driver and Sierra Print Artist if you want
transfer your pictures to the computer, edit your images, to install it.
and insert them into documents. You can also send your 6  Click Install and follow the instructions on the screen
images over the internet and turn them into screen-savers.
The included CD-ROM has these three applications: EPSON
PhotoPC 500 imaging software, EPSON Photo! TWAIN NOTE

driver and utility software, and Sierra Print Artist.

to complete the installation.

Don’t restart Windows until all the software programs have been

Follow these steps to install your software from the installed.

CD-ROM:

You now have the following new program groups (or folders):
1 Insert the PhotoPC 500 CD into your CD-ROM drive.

[0  PhotoPC 500 (PhotoPC 500 imaging software and

2 F Wi 9 Wi NT, 4.0 click th
rom Windows 95 or Windows NT, 4.0 click the start EPSON Photol TWAIN driver)

button, and then click Run.
[1 Sierra (Print Artist)

From the Windows 3.1 or the Windows NT, 3.51
Program Manager screen, choose Run from the file

menu.

3 In the dialog box, type: DNINSTALL. If your CD-ROM
drive is not drive D, substitute the correct letter.

4  Click OK. You see the main installation screen.
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1/2_\ Using Your PhotoPC 500 Camera

aking pictures with PhotoPC 500 is similar to
Tusing a traditional “point and shoot” camera. This
chapter shows you everything you need to know, including
the following information:
Turning the camera on and off
Saving power with auto shut-off
Using the control panel
Checking the battery icon
Snapping the shutter
Taking close-up pictures
Adjusting settings

Erasing pictures

o o o o o o o o dg

Checking the picture counter
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Turning the Camera On and Off

To turn the camera on, simply slide the power switch to the
ON position. The lens cover opens and the control panel on
the top of the camera lights up. The red standby light on
the back of the camera flashes for a few seconds. When it
stops flashing, the green ready light is on and the camera is

ready to take pictures.

red standby
green ready light

control panel light

power switch

To turn off the cameraq, slide the power switch to the OFF
position. The lens cover closes and the control panel turns
off.
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Saving Power with Auto Shut-off

If you wait more than 60 seconds before taking a picture,
the camera turns off automatically to save battery power.
To turn the camera back on, either slide the power switch
to OFF, then ON, or press the shutter button. You will have
to press the shutter button a second time to take a picture.

Using the Control Panel
The control panel keeps track of how many pictures you've
taken and provides important information about the

status of your batteries and the camera’s current settings.

resolution mode plctures taken

Plctures ' \ erase last
remaining image
self-timer \\\ ALZ'O
flash mode

battery level indicator




Checking the Battery Icon

Before you take pictures, check the battery icon on the
control panel. The icon shows how much battery power

you have left, in the following stages:
(AN} Full battery power (or AC adapter in use)

BN\ } to BN} Battery power is decreasing

attery power low (time to buy new batteries
.} Battery p low (time to b batteries)
) Battery power is almost out

; bg Change batteries

You should use the battery icon only as a guide to estimate

remaining power. Several factors can affect battery life,
including the surrounding temperature and the type of
batteries you use. Low temperatures (especially below
50 °F) weaken your batteries.

Snapping the Shutter
Follow these steps to take a picture:

1T  Turn the camera on and wait until the green ready

light comes on.

viewfinder

Look straight through the viewfinder and center your
subject. Make sure that the entire image you want in

the picture is within the viewfinder’s yellow frame.
Slowly press the shutter button.

Hold the camera still until it beeps and the red standby

light starts flashing.
green ready red standby
light light

shutter
button

The flashing red light indicates that the camera has
captured the image and is processing it. (If you try to press

the shutter button again, you'll hear an “error” beep.)
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When the red light stops flashing, the image is saved. Saved
images remain in memory for up to a year, even when the

camera is turned off and the batteries are removed.

You can take another picture when the red standby light
stops flashing and the green ready light is on. If the red
light flashes longer each time you take a picture, your

batteries are getting weaker.

NOTE

Remember that the camera shuts off automatically after 60
seconds. To turn the camera back on, either slide the power switch
to OFF, then ON, or press the shutter button to turn on the camera.

You will have to press the shutter button again to take a picture.

Taking Close-up Pictures

You should be at least 2 feet (60 cm) away from the subject
you are photographing. If you want to take pictures at a
closer range, you should use the PhotoPix LCD Monitor in

Macro mode or a 37 mm video camcorder close-up lens.
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For instructions for using the LCD monitor in Macro mode,
see page 11-12. For instructions on using a camcorder lens,

see page A-7.

If you use a close-up or “macro” lens for a camcorder, the
viewfinder does not give you an accurate representation of
your picture. You may want to connect the camera to your
computer and view your close-up images on the screen
before you capture them. See page 5-5 for information on

viewing and taking pictures from your computer.

You can take flash pictures within a range of 1.5 to 10 feet.

TiP

When you're taking pictures outdoors, make sure the sun is at your
back. In very bright light (at the beach or in snow, for example),
your pictures may come out too light. You can use an ND filter to

reduce the light. See page A-7 for information.




Adjusting Settings Flash

You can adjust the following three settings on PhotoPC 500 PhotoPC 500's built-in flash has four settings as listed
using the control panel buttons on top of the camera: below, which are effective within a range of 1.5 feet (Macro
mode with PhotoPix LCD monitor) to 10 feet. Press the flash

-/ Flash control button to cycle from one setting to another.
[J  Resolution
Auto
0 .
Timer AUTO The flash goes off automatically whenever it’s
Flash and resolution settings remain in effect even after & needed for adequate lighting (factory setting).

you turn off the camera.
Red-eye Reduction

The flash blinks on and off rapidly and then goes
© off. This prevents the light from shining directly

off the subject’s pupils and making them appear
red. Use this setting when you take pictures of

people or animals and you want the flash to go off

automatically.

resolution timer flash erase Flash Off
(& The flash is disabled, even when adequate lighting

is not available. Use this setting for special effects,

NOTE

The controls return to their factory settings when you remove or

or where flash photography is prohibited.

change the batteries.
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Forced Flash
The flash goes off with every picture you take. Use
this setting to compensate for backlighting; for

example, when you are facing the sun.

Resolution

PhotoPC 500 has two resolution settings, high and standard.
Press the resolution button to switch from one setting to the
other. The settings appear on the control panel.

High resolution
Hi Camera captures images at 640 x 480 pixels. Your
pictures include more detail, but the camera only

holds 30 pictures (factory setting).

Standard resolution
Camera captures images at 320 x 240 pixels. The
S camera holds 60 pictures, but the image size is

smaller and contains less detail when enlarged.

You can switch freely between the two settings and store
both standard and high resolution pictures in the camera.
The camera’s capacity varies accordingly. This is because a

high resolution image uses twice as much memory as a

2-6 Using Your PhotoPC 500 Camera

standard resolution image. For example, the camera holds
48 pictures if you take 12 at high resolution and 36 at low

resolution.

TP
Choose high resolution if you want “snapshot”-size or larger

pictures. Standard resolution is sufficient for “wallet”-size pictures.

The following examples show the same image captured at

standard and high resolution.



Standard resolution image
320 x 240 pixels High resolution image
640 x 480 pixels
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Timer

between the time you press the shutter button and

\-: Setting the timer creates a 10-second delay

the time that the camera actually captures the
image. This allows you to take a picture of
yourself. The timer icon on the control panel

flashes when you use the timer.

Follow these steps to take a picture with the timer:

1

Secure the camera on a flat surface or on a tripod. (See
page A-7 for information on attaching the camera to a

tripod.)

Turn on the camera and wait until the red standby

light stops flashing.

Press the timer button. The timer icon on the control

panel flashes.
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4 Press the shutter button. The red timer light on the
front of the camera comes on and stays on for 7
seconds. Then it flashes three times.

timer
button

red timer
light

The camera beeps when the image is captured. The red
standby light on the back of the camera flashes as
PhotoPC 500 processes the image. When the red light stops
flashing and the green ready light comes on, the timer is off

and you can take another picture.



Erasing Pictures
N If you don’t want to keep the last picture you took,
\l you can erase it from the camera’s memory. Using

a small pointed object such as a pencil, press the

erase button on the top of the camera. The erase

icon on the control panel flashes when you press
the button.

After a few seconds, the last picture you took is erased from
the camera’s memory. The picture counter (number of
pictures taken) decreases by one. You can continue pressing

the button to erase more pictures, if you want.

If you have the optional LCD monitor, you can use this
button to selectively erase any picture on the camera. See

page 11-7 for more information.

TP
You can also erase all the pictures in the camera’s memory. While
holding down the erase button, press the timer button. The erase

icon flashes until all the pictures are deleted.

Checking the Picture Counter

The large number in the center of the control panel shows
how many pictures you have taken. The smaller number
on the left below the resolution mode shows how many

additional pictures you can take.

pictures remaining pictures taken

2 =
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o
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/
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The number of pictures remaining depends on your
resolution settings. A high resolution image uses twice the
amount of memory in your camera that a standard
resolution image uses. Therefore, if you switch between
standard and high resolution, the number of pictures
remaining changes. For example, if the number of pictures
remaining is 4 at high resolution, it changes to 8 if you

switch to standard resolution.

When the camera’s memory is full, the number of pictures
remaining is 0. The green ready light on the back of the
camera goes off, the red standby light remains on, and you
can'’t press the shutter button. You need to connect the
camera to your computer and transfer the pictures. Then

you can erase the images and start taking pictures again.
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) 3 \ Connecting to Your Computer

W hen you're finished taking pictures you can

connect the camera to your computer and transfer

the images. This chapter covers the following:

Connecting PhotoPC 500 to your computer
Connecting with the optional LCD monitor
Setting up the camera connection

Adjusting auto shut-off

O o o o g

Setting the camera’s clock

Connecting PhotoPC 500 to the Computer

Make sure you do the following before you start:

[J Locate the serial cable that came with your camera.

[J  Make sure the camera has finished processing.

O If you have the optional AC adapter, use it when you
connect the camera to your computer. See page A-5 for

instructions on using the AC adapter with the camera.

NOTES

0 The AC adapter should be available where you bought your
PhotoPC 500. See page A-2 for information on ordering an AC
adapter through EPSON.

0 If you have a 25-pin serial port, you can use a 9- to 25-pin
adapter with your cable connector. See page A-8 for

instructions.
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Follow the steps below to connect the camera to the 3 Locate the port cover on the side of the camera. Press

computer: on the arrows and slide the cover up to open it.

T Locate a serial port on the back of your computer. You
may have two serial ports labeled COM1 and COM2, or

the ports may be labeled with icons.

2 Line up the serial connector on the cable with one of arrows
the serial ports on your computer, and insert the

connector. Then tighten the screws.

screws

serial port

3-2 Connecting to Your Computer



4 Line up the arrow on the cable connector with the

notch on the camera’s serial port. Then insert the

connector.

serial port

5 Turn on the camera and your computer system. A line
appears at the bottom of the picture counter on the

camera’s control panel.

g 75]&

O) 4

line

NOTE
When the camera is connected to your computer, you can’t use any
of the control buttons or the shutter button on the camera. You can

only operate these features through the computer.

The auto shut-off feature remains in effect when the
camera is connected to your computer, but shut-off takes
place after 5 minutes of inactivity instead of 60 seconds. To
turn the camera back on, slide the power switch OFF and
ON again, or use EPSON Photo! to turn on the camera by
clicking the Controls tab, Setup tab, or Start tab. You can
adjust the auto shut-off time by following the instructions
on page 3-6.
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Connecting with the Optional LCD Monitor

If you want to connect the camera to the computer while
the optional EPSON PhotoPix LCD Monitor is attached,
follow these steps:

1  Tilt the bottom of the EPSON PhotoPix LCD Monitor up
to expose the port cover as shown.

port cover

2 Follow the steps on page 3-1 to connect the camera to

the computer.

If the EPSON PhotoPix LCD Monitor is on when you connect

the camera to the computer, it will turn itself off.

3-4 Connecting to Your Computer

Setting Up the Camera Connection

Now that you have connected the PhotoPC 500 to your
computer, you can use the EPSON Photo! software to adjust
the connection speed and port setting, if necessary. You can
also see information about your camera displayed on the

Setup screen.

Testing the Camera Connection
If the software displays a message in the status box
indicating that the camera is not connected, follow these

steps to test the connection:

1 Double-click the EPSON Photo! icon in the PhotoPC 500

program group.



EPSON Photo! opens with the following screen:

= EPSON Photal =
Stait | Camera | Files | Frames | Contioks | Setup |

EPSON

rFiolore sgo

gy

Etaca il
Phelaz

Camera ld AID Camera Version: v22.72a 9
V1.00eFC1 [C] Coppright 1996 Seiko Epron Corporation

Wiicome 10 EFSON Fhow

camera information and ID

If the camera is connected, the screen displays the
camera’s information and ID.

If EPSON Photo! does not detect the connection, try the
following:

[J Check the cables to make sure they are securely
attached.

[J  Check to make sure the camera has not shut off

automatically.

3 To check the connection after making any

adjustments, click the Setup tab. The Setup screen
appears.

Setup tab

=

I PSON Photol E
Start | Camera | Files | Frames | Controbs | Setup |

Connect 103 Came @ of Changt 3 s satngs.

click to test
connection
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Click the Test Connection button. If you see the
camera information as shown on the previous page,
the camera connection is complete. If you see an error
message, you may need to change your port and speed
settings.

Adjusting Port Settings
You can manually change the port or communication

speed if EPSON Photo! is unable to detect the camera or

download photos. Follow these steps:

1
2

Open the Setup screen as described on page 3-4.

Click the arrow to change the port setting. You can
choose Auto, COM1, COM2, COM3, or COM4.

NOTE

In most cases, it is best to leave the Port setting on Auto
because EPSON Photo! can detect the location of the camera
automatically. When you change the port setting, you lose the

connection between the camera and your computer.

If possible, you should keep the camera connected to
the COM1or COM2 port on the computer.

If you have a serial device connected to one port and
an internal modem on the other, you can try COM3 or
COM4. If you get an error message, see page 12-3 for

more information.

Click the arrow to change the speed setting.

NOTE

EPSON Photo! automatically chooses the fastest speed that
works with your operating system. This may actually be too
fast for the configuration of your port. If you get an error
message while trying to download photos, you may need to

choose a slower speed. For more information see page 12-4.
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When you are finished, click OK.



Adjusting Auto Shut-off

You can adjust the time the camera takes to shut off when

it is connected to the computer. Follow these steps:

NOTE
The auto shut-off time can only be changed while it is connected to

the computer. When the camera is not attached, the auto shut-off
time is 60 seconds.

1 Connect the camera to the computer and open the
Setup screen as described earlier in this chapter.

2 Click the arrow to select an auto shut-off time.

ol EPSON Phota! E
Stat | Camera | Files | Fromes | Controls | Sefup.
Post:  Avto e
Speed | Auto 3]
Camera Settings
camera’s Time: (2157
time Date: 9720736
and date Aulo Shutell |5 Minutes
Camera ld: (D
2 |
Conrect 103 CETHE of CLENgE 3 CITREIE CaTings. — = i Close I

click to change
auto shut-off time

click to set the

camera’s clock

You can choose 1, 2, 3, 4, or 5 minutes for auto shut-off.
The default is 5 minutes, so if you are afraid of running

down your batteries, you might want to shorten this
period.
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Setting the Camera’s Clock
PhotoPC 500 can record the time and date of your photos
automatically. When you transfer the pictures to the

computer, you can see exactly when each one was taken.

In order to have the time and date recorded, you need to set
the camera’s clock from the computer. The PhotoPC 500
clock will continue to keep time accurately until you
replace the batteries; at that point you will have to connect

the camera to your computer again and reset the clock.
Follow these steps to set the camera’s clock:

1  Connect the camera to the computer and open the

Setup screen as described earlier in this chapter.

The Time and Date boxes show the current settings of

your camera’s internal clock.

2 Click the Set Time button.

3-8 Connecting to Your Computer

You see a screen like the one below:

click arrows to
change time and date

= Set Camera Time and DatL

Tmei[1 =2 = feu 2
(HH:MM) I = =]

Date: |9 =i, Izu &=l ) 12036 =1 &I
(MM:DD-YYYY) B = =

" 4~ Copy From
=l Computer

click to use
computer’s settings

Click the Copy From Computer button to set the
camera to the computer’s date and time.

You can also click the arrows to change the setting or

type the numbers for the time and date in the boxes.

When you are done, click OK. EPSON Photo! updates

the time and date in your camera.
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W hen you are ready to transfer your images to your
computer, read this chapter to find out which

download method best suits your needs. This chapter
describes the following:

O PhotoPC 500 imaging software transfer

[0 Additional download methods

PhotoPC 500 Imaging Software Transfer
The EPSON PhotoPC 500 imaging software allows you to

transfer photos and download them directly into an

electronic photo album. You can open the pictures from the

album for organizing, editing, enhancing, and printing.
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Follow these steps to download pictures with your

PhotoPC 500 imaging software:

1

Make sure your camera is connected to the computer

and turned on, as described in Chapter 3.

Double-click the PhotoPC 500 icon in the PhotoPC 500
program group. PhotoPC 500 asks you to select a

project:

=‘ Select a Project

/|

=@ T

Acquire éLide Go to
Open Album OW  Template work  Exit
area PhotoPC 500

Click the Acquire button. PhotoPC 500 asks you to
select an album for organizing your downloaded

images.

Select an album from the Album menu or select New
Album and click Select.
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If you select New Album, PhotoPC 500 asks you to

name the album.
=[  Save NewAlbum
‘ File Name: | ~ |labm
OK I Cancel |

Type in a name for the album and click OK.

PhotoPCS500 asks you to select a source.

Make sure Epson Digital Camera is highlighted and
click Select. The EPSON Photo! Start screen appears.

Camera tab
|

= | EPSON Photo! - [ TWAIN Server ] =]

Start IEanLﬂal Files | Frames | Controls | Setup |

EPSON
. aww.;‘lr ~1]1)

Save To
Hbo R

Erase All

Photos

Camera Id: AJD % Hel
V1.00eFC1 (C) Copyright 1936 Seiko Epson Corporation G

Camera Version: v22-72a

;

‘Welcome to EPSON Photo!



7  Click the Camera tab. If you already know which
pictures you want to transfer by their image numbers,
or if you want to transfer all the pictures, you do not
need to wait for all the thumbnails to appear before
you transfer images. If you do not know the image
numbers, wait a few moments for the thumbnails to

appear.

8  Select the photo you want to transfer, or select multiple
photos by holding down the Control or Shift key and
clicking on the photos you want. To select all the
photos, click the Select All button.

NOTE

This transfer allows you to use the frame photo and high-quality
options. The high-quality option resizes your high-resolution photo
to 8.4” x 6.3” or your standard resolution image to 4.2” x 3.2,” but it
does not actually increase the resolution. The enlarged photo will
not look as good as the original, especially when printed. This mode
also slows down the transfer time and creates larger file. The frame
option adds a permanent frame to your image. This feature reduces
the size of your image. For information on selecting frames for the

frame photo option, see Chapter 5.

=| EPSON Photo! - [ TWAIN Server] o |
Stat  Camera | Files | Frames | Controls | Setup |

Selectimages to retieve from the camerm. ‘

click to select  (ick to

statusarea gl the photos  transfer photos

9  Click the Get Selected Photos button. The status area
displays your progress as the images are transferred.
10 Click Close when all your pictures are transferred.

You see the images as thumbnails in your new
PhotoPC 500 album. You can edit the images by

opening them as described on page 6-5.

11 Save the album by clicking the Save button.
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Additional Download Methods

Besides using the PhotoPC 500 imaging software, there are
six additional methods for transferring images to the
computer. Read the descriptions below to decide which one

you may want to use.

NOTE

Some methods allow you to use the frame photo and high-quality
options. The high-quality option resizes your high-resolution photo
to 8.4” x 6.3” or your standard resolution image to 4.2” x 3.2,” but it
does not actually increase the resolution. The enlarged photo will
not look as good as the original, especially when printed. This mode
also slows down the transfer time and creates larger file. The frame
option adds a permanent frame to your image. This feature reduces
the size of your image. For information on selecting frames for the

frame photo option, see Chapter 5.

TWAIN Transfer
You can use any TWAIN-compliant application, such as
Adobe Photoshop or the PhotoPC 500 imaging software, to

transfer images to your computer without saving them in
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albums. The images are opened in the work area and you
can save them as individual files, or add them to albums
later. (See page 4-5.)

Direct Hard Drive Transfer

You can use EPSON Photo! as a stand-alone utility
application to download your pictures quickly and directly
to the hard drive. The file names in this method are long, so
you'll need to find your pictures by their thumbnails. If you
want an easier method of organizing your files, you should
use the PhotoPC 500 transfer method, described on page 4-1.

(See page 4-7 for instructions.)

Export Photo Transfer

You can use the EPSON Photol. export photo transfer
feature to save the image in any of four file types as you
transfer it to the computer. This transfer also lets you add a
permanent frame to the image. (See page 4-11.)



Insert Object Transfer

You can download an image directly from the camera into
Microsoft Word or PowerPoint“0 or any other application
that supports OLE (object linking and embedding) 2.00 by
inserting it as an object. (See page 4-12.)

Drag and Drop Transfer

You should check your system'’s configuration before you
use drag and drop. This method works best on fast systems
that have a large amount of RAM. Your system also needs a
screen resolution of greater than 640 x 480. Drag and drop
allows you to grab a thumbnail from the EPSON Photo!
Camera screen and drop the image directly into your
document. (See page 4-13.)

NOTE

If you choose either the insert object transfer or the drag and drop
transfer, you may also want to save the file in a PhotoPC 500 album
as described on page 4-1. These methods allow the picture to appear

in your document, but do not save it as a separate file.

Acquiring Images with TWAIN Programs

Follow these steps to acquire photos from the camera using
TWAIN-compliant programs such as Adobe Photoshop™
or PhotoPC 500 imaging software. These steps are based on
these two programs, so your software may have different
commands or menus. See your software’s help or

documentation for more information.

T  Open your application. Make sure the camera is

connected to your computer and turned on.

2 Click Select TWAIN Source (or Select Source) in the

File menu.

3 Select Epson Digital Camera as the TWAIN source.
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4 Select EPS JPEG Acquire (or Acquire) from the File 5 Click the Camera tab and go to the Camera screen.
menu.

Adobe Photoshop
Edit Mode |Image Filter Select Window Help
New...
Open...
Open As...
Place...

Close Ctrl+W
Ctrl+S

Export Select TWAIN Source...
TWAIN...

Page Setup...
Print... Ctrl+P

Preferences »

1 C:\..\EXPOPTS.TIF
2 C\..\PENCIL.EPS
3 C:\..\ERASE.EPS
4 C\..\2PENCIL.EPS

Exit Ctrl+Q

I RN A
RSN - B

L

2l

Select images 1o fetiieve from the camera.

/

selected click to transfer
photo photos

click to select
all the photos

The EPSON Photo! Start screen appears.

6 Select the picture you want to use, or hold down the
Control or Shift key and select multiple pictures. Click
Select All to transfer all the pictures.
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NOTE

If you want to put a permanent frame on your photo, click the
Frame Photo box. If you have not selected a frame style yet,
click the Frames tab and turn to page 5-8 for instructions on

selecting a frame. Adding a frame reduces the size of your

image and increases the transfer time.

7  Click the Get Selected Photos button. The status area
displays the progress as the images are transferred.
Then EPSON Photol closes and you see your images in

the work area.

Transferring Images Directly to the Hard Drive
You can transfer all your pictures to the hard drive or
preview and select pictures to transfer with a few simple

steps.

Transferring All Images
If you want to load all your pictures directly onto the hard

drive, follow these steps:

T In Windows 95 or Windows NT, 4.0 click Start, point to
Programs, and then select PhotoPC 500.

From the Windows 3.1 or Windows NT 3.5 program
manager, double click the PhotoPC 500 program

group.
Double-click the EPSON Photo! icon.

The EPSON Photo! Start screen appears:

= EPSON Photo! =
Stat | Camera | Files | Frames | Controls | Setup |

Hbo e

Camera Version: v22-72a

Wieloome o EPSON Photo! [ | iClose!

Camera Id: AJD
V1.00eFC1 (C) Copyright 1996 Seiko Epson Corporation

click to download images
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3 Click the Save to Folder button.

In Windows 95, the Browse for Folder dialog box
appears.

Browse for Folder HE

Choose a folder for photo storage:

-1 PhotoDlx |
#-{_] Photopls
{1 Pkzip
+-(_1 Printpak
=] Program Files
- Accessories
@-{_] Claris Corp

=-_1 Epson J
B-{_] Photo!
(2 Frames

= | Photos
1"_'| Program
#1.{57_SnanShat =

New Foider | ok | Concel |

0
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In Windows 31, the Choose Folder dialog box appears.

|=| Choose Folder
Folders: 0K I
P i Cancel I
[ epson :
= photo!
£ frames 1d I
£ photos Lol
Driyves:
c: msdos |£I Network. .. I

Select a folder for your photos.

If you want to create a new folder, select the directory
you want to place the folder in. Click the New Folder
button. Type the name of the new folder in the dialog
box and click OK. Then select the new folder.

Click OK. The status area displays your progress as the
images are transferred to the hard drive.

The images are saved in JPEG format. You can view

them on the Files screen as described on page 5-6.



Transferring Selected Images

You can preview and select the images you download by

following these steps:

1
2

Open EPSON Photo! as described on the previous page.

Click the Camera tab to view the Camera screen. It
takes a few moments for the thumbnails of your

images to appear.

Click a thumbnail to select an image you want to
download. To select more than one image, hold down
the Shift key or Control key and click the photos you
want.

Follow steps 3 to 5 on page 4-8 to transfer the images
you have selected.

Camera tab

=] EPSON Photo! >

Stat  Camera | Files | Frames | Controls | Setup |

1
If
il
1L

e e F5 ’»?Heln

Tranefer complete] [ iE| Close

selected image click to transfer selected
image(s)
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Reading File Names

EPSON Photo! uses the time, date, and photo number for
your images’ names. The format for these names is
explained below:

Windows 95 and Windows NT follow this naming format:

PhotoPC Monday, September 23, 1996 1008 AM 7.jpg

|
Open | 2] x|
Lookjn: |3 Photos o &l e =
PhotoPC Monday, September 23, 1996 1008 AM B.jpgé

PhotoPC Monday, September 23, 1996 1008 AM 7 jpg
PhotoPC Monday, September 23, 1996 1008 AM 8 jpgy

File narpe: | B
Files of bype: IAII Formgts j B |
File Size
file source time ) )
(PhotoPC500) date image EJI:)eGe)xtensmn
number
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File names in Windows 3.1 follow this format:
MMDDNNNN.JPG

MM = month

DD =date

NNNN = image number
JPG = JPEG file extension

= Open
e e .
if-".pexc™. iga:. pg:~ ped [SEEASPERBhatot —_—
_______ = o=
09210002.jpg I e -
09210003.jpg P Hetwork__.
09210004.jpg = photo!
09210005.jpg (] frames
09210006.jpg
09210007, ipg 3 photos
10008.jp =
_DIi!BS: .
c: msdos
month date image number file extension
(September)  (21st) (picture 8) jrg (jpeg)



Exporting Images

If your software application is not TWAIN compliant and

you want to download your photos in format that it
recognizes, you can use EPSON Photo! as a stand-alone

utility program to export your files in any of four file types.

T  Open your EPSON Photo! software and click the
Camera tab to open the Camera screen.

=] EPSON Photo!

Start Camera IFIB | Frames | Controls | Setup |

Click the picture you want to export.

The selected photo is highlighted in yellow and blue

and the Export Selected Photo button is active.

NOTE

If you want to put a permanent frame on your photo, click the
Frame Photo box. If you have not selected a frame style yet,
click the Frames tab and turn to page 5-8 for instructions on
selecting a frame. Adding a frame reduces the size of your

image and increases your transfer time.

Click the Export Selected Photo button. The Save As
dialog box appears.

Trnsfer complefe. / i T

selected picture click to export click to select
photo all photos

=l Save As
|a_h.njﬁ c:\epsonyphotol _
ERG e 5] Cancel_|

= photol
] rames E
Q2 photos Network.

Save File as Type: Drives:

Bitmap Files (~.bmp, = dil £| c: msdos 12
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4 Select the file type for the image from the Save File as
Type pull-down menu. You can save your image in
any of the following formats:

J Bitmap: BMP, DIB
00 JPEG
0 PCX
5 Type in a name for your file.

6 Choose the directory where you want to save the file
and click OK.

NOTE
You cannot open or edit the exported photos in EPSON Photol.
Use PhotoPC 500 or another application to view or edit the

exported images.

Inserting Images as Objects with OLE

You can use your images in applications that support OLE
(object linking and embedding) 2.0 or higher. Follow these
steps to insert a photo as an object:

T Open the document you are inserting the picture in.
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Make sure your camera is connected to the computer

and turned on as described in Chapter 3.

Select Object from the Insert menu. You see a list of

sources.
= Insert Object

b

IC Approach Worksheet +

St Hew Eatals e R

~ T

* Create hom Flle [ Fije Magic Document
HiJaak Image o Hew |
HJPAINT Picture
Lotus ScreenCam Movie 2.0 | Display As lcon

+

Media Clip

“Result
Ingetts & new EPSON Digtsl Cameta Object object o
your presentalion

Select Epson Digital Camera as the Source and click OK.
The EPSON Photo! Start screen appears.

Click the Camera tab to view the Camera screen.

Click the image you want to insert. It is highlighted in
yellow and blue.

Click Get Selected Photo. The image appears in your

document.



Using Drag and Drop

If your application supports OLE (object linking and
embedding) 2.0 or higher you can use this method to
transfer your pictures from your camera into your
documents. Follow these steps:

NOTE

You can only use drag and drop if your screen resolution is greater
than 640 x 480 pixels. Some applications do not support the millions
of colors in your Photo PC 500 images. If you drag and drop your
picture into one of these programs and it appears blotchy, try
transferring your picture into PhotoPC 500 and changing the image
mode to indexed, 256 colors as described on page 7-10. Then import
or cut and paste the image into the application as explained in
Chapter 9.

Click the center of the image you want to insert and
drag it to your document, holding down the button on

your mouse while you drag.

Release the button of your mouse when the object is
placed in the document where you want it. The image

appears in your document.

= i Word - Di 1 =

T Open the document you want to place a picture in.

2 Make sure the camera is connected to your computer
and turned on as described in Chapter 3.

3 Open EPSON Photo! and click the Camera tab to view
the Camera screen.

oo

=| File Edit Yiew Insert Format Tools Table Window Help

-:I-—--@WEI@

“r e
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/]5 \ Using the Camera with Your Computer

You can adjust the camera controls from your Using the Camera Controls

computer just as you would by using the control When the camera is connected to your computer, you
panel. You can even take a picture from the computer cannot adjust the controls on the camera’s control panel.
while viewing a live preview of your subject, which works Instead, you can use EPSON Photo! by following these steps:

well when you are taking portrait photos or close-ups with

Make sure the camera is connected to your computer
a macro lens. This chapter includes the following y P

and turned on, as described in Chapter 3.
information about using the camera with your computer: p

2 In Windows 95 or Windows NT 4.0 click Start, point to
Programs, then select PhotoPC 500.

Using the camera controls

Erasing pictures from your camera

Setting the shutter speed From the Windows 3.1 or Windows NT 3.5 Program

Manager, double-click the PhotoPC 500 program group.
Taking pictures from the computer

Using file folders

O o o o o od

Setting up frames for your photos
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The Start screen appears:

=] EPSON Photol = = EPSON Photal =
Start | Camera | Files | Frames | Controls | Setup | Stant | Camera | Files | Frames | Controls || Sotup |
(&)t
Contiol Option:
Rezolution: Eraze Photos:
[wigh oy %] [ D'JJ )| — | |
C— S -
[} il Shuttes Speed: | Automatic | #]
Eiase Al Live Provicw
Pholas Use the Stast and FPreview:
m“u':'i? Start | Stop I
b i S Auto-Stop Timer
%’.‘.‘:“"‘ it 8]
w.m%tﬁﬁm f’sﬂ‘.l:?.:m‘?«?'.m ? tiske ? tee
Wascome 1o EPSON Phoit [ = 'E' ﬁ I Ure te conmecied came sl coviicks [ 1 Cose |
3 Click the Controls tab to view the Controls screen, See page 2-2 for more information on using the
shown to the right. camera’s controls.
The control panel lets you do the following: . .
P Y J Erasing Pictures from Your Camera
[0 Check the battery icon to see how much power is After you have viewed your pictures and transferred them
left in the camera. to your computer, you can erase them from your camera
[J Change the flash and resolution settings just as using either the Camera screen or the Controls screen.

you do on the camera by clicking on the arrows

and highlighting the settings you want to use.
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Erasing Photos from the Camera Screen 3 If you want to erase all of your photos, click Select All.

Follow these steps to erase photos from the camera usin
p P 9 If you want to erase one of your photos, click the photo
the Camera screen: . .
to select it. Select more than one by holding the Control

T  Open EPSON Photo! as described on page 5-1. or Shift key and clicking the images you want.
2 Click the Camera tab to view the Camera screen. 4 Click Erase Photos. A message box appears asking to
confirm your selection.
= TRSON Fhotal |
St Camera | Fles | Frames | Contras | Setup | 5 Click Yes to erase the photos in your camera or click No

to cancel.

Erasing Photos from the Controls Screen
Follow these steps:

T  Open EPSON Photo! as described on page 5-1.

|\

i
1|
1

Temster comsled

selected photo click to select all click to erase
photos photos
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2 Click the Controls tab to view the Controls screen.

EPSON Photo!

click to erase last
photo

3 Under Erase Photos, click All to erase all the photos or
click Last to erase the last image that you captured.

A message box asks you to confirm your selection.

click to change
shutter speed

B Taks &
() Porae
Control Dpiions
Resolution: Erase Phatas:
[High 1y 3 Laat | a0 |
Timer Flash:
|on Automatic | &
Live Proview r
Use the Stat and Freview:
butions to
mu";" Start I_Snl" l
Dlmnnlim
aview wop r
e Auto-Stap Tisper:
imes expires or 1 Minaite: =
anather tab iz
el
D
g e i e —

click to erase all
photos

4 Click Yes to erase the photos or No to cancel.

5 Click Close when you are finished.
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Setting the Shutter Speed

When the camera is connected to the computer, you can
use the Controls screen to adjust the shutter speed. Slower
shutter speeds allow more light to strike the lens; faster
speeds allow you to take “stop-action” pictures of moving
subjects. Shutter speed settings remain in effect only while
the camera is connected to your computer. The camera

adjusts the speed automatically when it is not connected.

NOTE
When you adjust the shutter speed manually, you can’t use the

camera’s flash.

Follow these steps to adjust the shutter speed:
T  Open EPSON Photo! as described on page 5-1.
2 Click the Controls tab to view the Controls screen

3 Select the shutter speed you want to use from the

Shutter Speed pull down menu.

The camera uses the shutter speed you select as long as

it is connected to the computer.



Taking Pictures from the Computer
You can take pictures while you are controlling the camera
from your computer. This allows you to see a live preview

of your subject and get the perfect shot. Follow these steps:

1T Connect the camera to the computer as described in
Chapter 3.

2 Position the camera facing the subject. Using a tripod
will give you the most control when setting up your

shots. See page A-7 for instructions.

3 Turn on both your camera and your computer system.

4  Double-click the EPSON Photo! icon.

5 Click the Controls tab to view the Controls screen.

= EPSON Photo! |=

Start | Camera | Files | Frames Controls | Setup |

Take a
Picture

Control Options

R

= Erase Photos:

AL 09D L la

Timer: Q') ] 5 Flash:
(113 !l Forced !I

Shutter Speed:  Automatic 2'

Live Preview

Use the Start and
Stop buttons to
control the live
preview. Live
preview will stop
when the auto-stop
timer expires or
another tab is
selected.

|

Use the connected camerd's contrls

|

click to start click to stop click to adjust click to take
live preview live preview preview time apicture

Press the Start button under Preview to display the

image on the screen.

You may need to move the camera or the subject until
you see the image you want to capture in the window.
The image is updated every eight to ten seconds,

depending on your communication speed.
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NOTE

The Live Preview has an auto-stop timer that shuts the preview
off after a short time to save batteries. You can adjust this
time by clicking the button and highlighting the time you want
to use. If the timer stops the preview, just press Start and the

image will appear again.

8 When you see the image you want to capture on the
screen, press the Take a Picture button to snap the
shutter.

9  Click Stop to stop the preview. Transfer your picture to
the computer as described in Chapter 4 and turn off

the camera.

Using File Folders

EPSON Photo! allows you to view and erase picture files
and their information. The file folders are useful for finding
pictures you have transferred using the export photo
method, described on page 4-11 or the direct hard drive
transfer, described on page 4-7.
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Viewing Files in Folders
Follow these steps to view thumbnails of files in folders:

T  Open the EPSON Photo! software as described on page
5-1. Click the Files tab to view the Files screen.

7 EPSON Photo! [ x]
Cortrols | 4 Setup |

Browse... | C:\Program Files\Epson'\Photol\Photas'

Select images to retrieve from a disk folder. T Close

The default folder is EPSON\Photo!\Photos.

2 If your photos are not on the screen, click Browse and
select the folder where your photos are located. Your
images will appear as miniature “thumbnails” in the

boxes on the screen.



3

Use the arrows to scroll through additional images.

Displaying File Information
Follow these steps to see information about the images you

have saved in folders:

T Open the folder where your image file is located.

2 Select the image you want to see information for. (The
selected photo is highlighted with yellow and blue.)

3 Click the Photo Info button to view the selected photo’s
information. If the information is available, you see the
date, time, shutter speed, flash mode, and image
resolution displayed.

NOTE

You can also view image information by clicking a thumbnail with

the right mouse button.

Erasing Files from Your Hard Drive
Follow these steps to erase image files stored on your hard

drive:

T  Open EPSON Photo! as described on page 5-1.

2 Click the Files tab to view the Files screen.

3 Select the photo you want to erase or select multiple
photos by holding down the Control or Shift key and
clicking on the pictures. To select all the photos, click
the Select All button.

The selected images are highlighted in blue.

4 Click the Erase Files button. A message appears asking
you to confirm the deletion.

5 Click Yes to erase the image files or click No to cancel.
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Setting Up Frames for Your Photos
You can set up permanent frames to add to your images
with EPSON Photol Follow these steps:

1T  Open your EPSON Photo! software. Click the Frames tab
to open the Frames screen.

2 Click on the frame style you would like to use. A

preview appears in the window.

3 If you want to change the color of the frame or the

matte, click Frame Color or Matte Color.
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frames tab

click to
edit colors

EPSON Photo!

Start

Camera

Styles:

Preview:

Files Frames | Controls | Setup |

-IC

=

:

Select a frame style 10 surround retiieved |mages.

frame preview

| | Close

click boxes
to select
frame type



The following screen appears:

click for
new colors

=] Color
Basic Colors:

| 5y

L1 1 ] e ]
EEEEOECEC]

Lustom Colors:
N
N

Define Custom Colors....

s

Select the color you want and click OK.

click boxes to
select color

If you want to define your own color, click Define

Custom Colors to view the color palette, as shown on
the right.

[0 Move the crosshairs to select a color.

[0 Move the arrow on the light/dark scale to make

the color darker or lighter.

[0  Type in numbers to adjust the hue, saturation,

luminescence, red, green, and blue values for the

color.

A preview of your color appears in the Color/Solid

window.

Click Add to Custom Colors to add your selected color.

Your new color appears in a box under Custom Colors.
Select your new color and click OK. The frame or matte

appears in your selected color.

selection
crosshairs

= Color

Basic Colors:

[ | ] o |

] .

O (] I T

I ] ...

1 1 1 femf ]

I [ () T ]

LCustom Colors:

LI

L [ o e =

Define Custom Colors... | /ColordSolid |y (101 Bie: [165

|| cancet || mew [ | dd to Custom Colors! |

i click to add adjust
color preview color light/dark
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/)6 \ Albums: Managing Files in PhotoPC 500

=‘ Album - photos.abm

‘ Album: |phmas.abm |E|

] s 2 a2

ocl11_002 jpy oc11_001 jpg

i
|lake2 jpg 08190001 jpy park jpg

08190002 jpg

ocl1_007 jpg

Description: |

Infarmalion:| Date: 8/19/896 Size: 52 KB Wicth: 640 Height: 480

File Name:| c'artiepsi08190003 jpg

E ] ou can use PhotoPC 500 to organize all the

pictures you take with your camera. This chapter

describes how to use the PhotoPC 500 features in the

following sections:

o o o o o o o g

Transferring saved images to albums
Working with your albums

Sorting your albums

Opening image files

Printing your pictures

Saving your pictures

Viewing your album as a slide show

Using your album as a screen saver
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Transferring Saved Images to Albums
If you didn’t acquire your photos with PhotoPC 500, you

can still open the images you downloaded with your

EPSON Photo! software and save them in albums. Follow

these steps:

1

In Windows 95 or Windows NT 4.0, click Start, point to
Programs, and then point to PhotoPC 500 to open the

application.

From the Windows 3.1 or Windows NT 3.5 Program
Manager, double-click the PhotoPC 500 icon in the
PhotoPC 500 group to start the application.
PhotoPC 500 asks you to select a project.

=| Select a Project

w67 ]

Click the Album button ﬁ to open one of your

albums or to create a new album.

6-2 Albums: Managing Files in PhotoPC 500

The Album opens as shown:

click to select  click to add
an album afile

FEEERR bz

o

elephints jpo

N

7 A 5
rainbow Jng storsjpg

canyon jpg

| skyipg | | waterjpg | | woodjpg | marble tif sand tif

Descriptign:‘ThiS album contains ten images found on on .A\PHOTOS and .\PA

Information:‘ Image files in album: 10

File Name:‘

Click the down arrow to select a different album or

select New Album to create a new album.

Click the Add button |[@| to add one of your image

files.




The Add Thumbnails dialog box appears.

=| Add Thumbnails
File Name: Directories:
".tif:'.pcu:‘.lga:‘.i)g:'.pcd | c:\photopc5iphotos
Tbe = o |_Cancer |
ball il
barion B ettt |
birds_jpg [Leiiss
boats_jpg
boulders.jpg
canyon.jpg
dock j +
List Files of Type: Drives:
‘AII Image Files |£I | c: msdos EI

Select a file to add to your album and click OK. The
image appears in your album.
B

you chose New Album, the Save New Album dialog box

Click the Save button to save your album

appears.

= Save New Album

‘ File Name:D.abm
OK I _Qancell

Type a name for the album and click OK.

Working With Your Albums
PhotoPC 500 Albums store and display your images, just

like the photo albums used for printed snapshots. You can

organize your pictures by subject matter or date, or in any

way you want. Albums let you view miniature

“thumbnail” versions of your images, along with image

information.

1

To open your album, click the Album button @

or choose Open Album from the File menu.

The Album window appears, with miniature
“thumbnail” representations of your image or images,
as shown on the next page.
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[0 Click and drag a thumbnail to rearrange the

=| Album - photos.abm =

‘ Album: |photes.abm !l i!”!lﬁnﬁlﬂ"j"ﬂl

images in the album.

O Click the Acquire button ! and follow the steps
on page 4-1 to download photos directly to your

album.

[0 Click an image and click the Delete button .i |
toremove it from the album. The image file itself is

oc11_002 jpg

not affected.

lake2 jpg 08130001 jpg park jog 08190002 jpg _007 j D

Print out the whole set of thumbnails by clicking
Dcscrlp(lon:| | the Print button. ﬁ

Information: | Dats: 8/19/96 Size: 52 KB Wicth: 540 Height: 480
File Name: | c'art=ps\08190003 jog

3 Enter a description for the album (up to 36 characters)

in the description box, if you want.

4 Click the Save button % to save your album.

[ Click an image to select it. The Information box

displays image file information. 5 If you're finished working with albums, click the Exit
[ Double-click a thumbnail to open the image. button ﬂ .
0 Toadd pictures, click the Add button

and choose the image or images you want.

[0  Click the down arrow at the top of the screen to

see a different album or create a new album.
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Sorting Your Albums

PhotoPC 500 gives you several methods for sorting the
images in your albums. You can sort them by file name, file
size, file type, file date, or description. Follow these steps to
organize your photos:

T Open the album you want to sort.

2 Click the Sort button. %1
The Sort dialog box appears as shown on the right.

3 Select the sort method you want to use.

4 If you want the images to appear in reverse order (Z to
A instead of A to Z, for example), click the Reverse
Order box.

5 Click OK when you are finished. The images appear in
the order you have selected.

=/ Sort Album

O By File Size
By File Date
O By Description

click to reverse
order

Reverse Order

Cancel I

|

Opening Image Files

With the PhotoPC 500 imaging software, you can have
several images open at the same time (depending on your
computer’s memory), each in its own window. The
window's title bar is highlighted if it contains the active
image (the one you're currently working on). You can even
open the same image in two windows; this lets you

experiment while you keep the original picture in view.

You can open an image using either the Album button or
the Open button.
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Opening an Image in an Album 4 When you have finished opening the images you want

When you use albums, you can see small thumbnail to work with, close the Album window. Your images

versions of your pictures. You can easily choose the image appear in the PhotoPC 500 workspace where you can

you want, even if you don’t remember the file name. Follow edit them.

these steps:

1 . ﬁ =| Album - photos.abm -
Click the Album button or choose Open Album

‘ Album: photos.abm !' H!Iﬂ'ﬁlﬂlmlﬂl@

from the File menu. The Album window appears, as

shown to the right.

2 Double-click the thumbnail to open the image you

oc11_002 jpg

want.

3 If the picture you want to open is in a different album,

i ' 1 6 : . o]
click the Album arrow at the top of the window and
choose a different album.

Descrlpllon:| |

Information:| Dats: 8/19/95 Size: 52 KB Wicth: 540 Height: 480
File Name: | c'art=ps\08190003 jog
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Opening an Image with the Open Button
If you want to open an image that’s not in an album, you

can use the Open button. Follow these steps:

1T Click the Open button . The Open dialog box

appears.

2 Choose the image file you want to open. The
PhotoPC 500 imaging software lets you open the
following types of image files:

1 BMP 0 TGA
0 TIF 0 JPG
0 PCX 7 PCD
1 GIF

NOTE

For more information on image file formats, see page 6-8.

Printing Your Pictures

When you want to print out your image, follow these steps:

1
2

Open the image you want to print.

Click the Print button ﬁ or choose Print from the
File menu. The Print dialog box appears:

=| Print

Printer Name: Epson Stylus COLOR 500 on LPT1:
File Name: c:\photopc5iphotosipark.jpg

Desclipiinn:}A lovely neighborhood palk| ‘

Copies: E
Hori-Centered

[d Vert-Centered
Output: 150 dpi
L«

Wicth: 4.3 Inch Height: 3.2 Inch

If you want to place a title or caption below the

picture, type it in the Description box.

Enter the number of copies you want to print. (This

option is available only if your printer supports it.)
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5

8

If you want to change the position of your image on
the page, move the picture in the window.

Use the Hori-centered and Vert-centered checkboxes
to indicate if you want to center your image on the

page horizontally, vertically, or both.

Drag the slider if you want the printed image to be

larger or smaller than the original image.

NOTE

The resolution automatically increases if you reduce the size
and decreases if you enlarge it.

Click OK when you're ready to print.

Saving Your Pictures
Follow these steps to save a picture in the PhotoPC 500

imaging software:

1

Click the Save button % or choose Save As from the
File menu.
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The first time you save your image file, the Save As
dialog box appears:

=| Save As
File Name: Directories:
| picture.ipg ‘ c:\photopcSiphotos
o e 3 & :
ture2.
pictures1pg [ photopch Network.. I
= photos
T Quality: 100
. - ST L
Save File as Type: : Drives: :
=JPG _EI c: msdos pd

Choose the drive and directory where you want to
save the file, or leave it in the default location
(C:\PhotoPC5\Photos).

Choose the file type. The PhotoPC 500 imaging
software lets you choose from five file formats. Each

format has a different internal structure and use:

[J JPG.JPEGis the default format and produces small,
compressed files. When you save in this format,
the screen displays a slider that allows you to
choose a degree of compression. For best quality,
choose 100 percent.



[J  BMP. This is the “native” format for Windows
bitmap files. This format is the best for importing
files into other Windows applications.

O  TIF. TIFF files can be used on many types of
systems.

[J PCX.The PCX format lets you use your pictures in
many Windows and DOS programs.

0 TGA Targa files were originally designed for

specialized hardware and software.

4 Type a name for the file and click OK.

Viewing Your Album as a Slide Show
You can turn any album into a slide show that you can
share with friends, co-workers, and family members. For
instructions on how to create an album, see pages 4-1
and 6-2.

Follow these steps to turn your album into a slide show:

1 Click the Slide Show button|Z2)| . You see the Slide

Show dialog box (shown below).

leave checked to
view effects

leave checked —]

to continuously Slide Show: Seconds
play slide show

Click the down arrow and choose the album you want

to use.

When you leave the Transition Effect box checked,
PhotoPC 500 displays various fades and dissolves
between images. If you don’t want these effects, click

the Transition Effect box to remove the check.

= Slide Show
click to select
; |
L ovorteabm | e

—&d Transition Effect

£ Auto Loops

enter time

Press Esc key to exit slide show | ~ between
images

[ ok | ‘_Cancell

4 When you leave the Auto Loops box checked,

PhotoPC 500 plays the slide show continuously (until
you press Esc). To play the slide show only once, click

the Auto Loops box to remove the checkmark.
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5 Enter the number of seconds you want to see each

image.

6  Click OK to start the show. You can press Esc to exit the

show at any time.

Using an Album as a Screen Saver

A screen saver is like a slide show that plays whenever
your computer is idle for more than a few minutes. You use
the Windows Control Panel to turn an album into a screen

saver.

NOTE
If you need help creating a screen saver, see your Windows

documentation.

Follow these steps:
1T Open the Windows Control Panel.

2 If you're using Windows 95, select Display, and then

click the Screen Saver tab.
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If you're using Windows 31, double-click Desktop. You
see the Screen Saver dialog box.

Click the Screen Saver Name down-arrow to display
the list, and choose PhotoPC 500 Slide Show.

Click Settings or Setup.

Choose the album you want to use, and set the other

options if you want. Click OK when you're finished.
Set the Wait or Delay time.

Click Preview or Test if you want to see a sample of

your screen saver.

Click OK when the screen saver is set up the way you

want.
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our PhotoPC 500 imaging software lets you edit
Y your images to improve their composition, size, or
appearance. You can crop edges you don’t want, copy and
paste parts of one image into another one, or convert the
image type so you can print it in black and white or use it
in an application. This chapter includes instructions for:
Viewing images and image information
Selecting part of your image
Cutting, Copying, and Pasting
Cropping
Resizing
Rotating

Flipping an image or selection

O o o o o g g g

Converting image types

Viewing Images and Image Information
To get a close-up look at part of your open image, you can
use the Zoom tool or Zoom In command on the View menu.
You can also use the View menu to display information
about your image and to hide the Tools Bar and Status Bar
on your PhotoPC 500 screen.

NOTE
You are not actually changing the image size when you zoom in. If
you want to change the size, use the Resize tool or the Image Size

command on the Edit menu. See page 7-7 for instructions.

Zooming In and Out with the Zoom Tool
Follow these steps to get a close-up look at your image and

then return to your original view.

1 Click the Zoom tool @ .
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2 Click the left mouse button on the part of your image The image is magnified to twice its size.

that you want to see in detail

3 Continue clicking to increase the magnification. You

can increase it up to 16 times its original size.

4 To decrease the magnification, click the right mouse
button on the image. You can continue to click the

right mouse button to zoom out even more.
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Using the Zoom Commands in the View Menu [0 Select the units you want to use for displaying the
Follow these steps to zoom in and out on your image from image’s dimensions. You can select pixels, inches, or

the View menu: centimeters.

T Choose Zoom In or Zoom Out from the View menu.

= Image Information

You see a list of magnification ratios: ———

File Name: c:\photopc5iphotos\canyon.jp
Width: 450 Pixel

View Height: 306 Pixel
LT Resolution: 150 dpi
‘oom Ou

Data Size: 405K Bytes
Data Format:  True Color [24 Bits)

Full Screen Ctri+w

Image Information... Ctri+l

¥ Show Tools Bar Ctri+L
¥ Show Status Bar Ctrl+N

IR T INNEREN]

Pl
| ® Pixel Olnch O Cm ‘

:10
11
112
(13
o [J  Click Histogram to display a graph like the one below:

1
1
1
1
1
1
1
1:9
1
1
1
1
1
1
1:16

Image Histogram

2 Choose the degree of magnification or reduction you ®RGB,
want. O Red

O Green
' Blue

Viewing Image Information
Choose Image Information from the View menu to display

an information box like the one below.
The histogram shows the brightness of the overall image
and each of the three color channels (red, green, and blue)

that make up the image. The vertical axis of the graph
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represents the number of pixels. The horizontal axis
represents the brightness level, from the darkest pixels at
the left to the brightest pixels at the right.

Click OK when you're finished with each information box.

NOTE

When you enhance an image, change its size, or convert it to
another file type, PhotoPC 500 shows your changes in the Image
Information box. The histogram reflects changes in brightness and

contrast, hue and saturation, tone, and sharpening or blurring.

Hiding the Tools Bar and Status Bar
To create more space for displaying images on your
PhotoPC 500 screen, you can hide the Tools bar or Status

bar. Follow these steps:

1 From the View menu, choose Show Tools Bar or Show

Status Bar. The checkmark disappears from the menu.

2 Torestore the Tools or Status Bar, choose Show Tools
Bar or Show Status Bar again. The checkmark

reappears.
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Selecting Part of Your Image
Selecting or masking a portion of your image allows you to
make changes that affect only that portion. The rest of the

image isn’t affected.

Using a Selection Mask

When using a selection mask, you can choose the Discard
command on the Edit menu to cancel all changes made to
the selected area. This lets you experiment freely, knowing

you can undo a series of changes quickly and easily.

Follow these steps to select a part of your image:

1 Click the Select tool| L %

2 Click and drag the mouse to select the part of the

image you want.



When you release the mouse button, an “animated” Once you have added a selection mask, you can work with

rectangle surrounds the selected area: it by following these procedures:

O

PhotoPC 500 - [cicamartjboats.jpg]
File Edit View Ephance Effects verl  Window  Hel,

NOTE

After you select an area, you can use many of the PhotoPC 500
menu commands and tools to work on the area. For example, you
can use the Crop, Resize, and Rotate tools. See pages 7-6 to 7-8

for more information about cropping, resizing, and rotating.

To move the selected areaq, click and drag inside the

area. The selection “floats” on top of the original image.

To decrease the size of a selection or change its shape,
press Ctrl while you select part of the already selected

areaq.

To remove the selection mask, click anywhere outside

it, or press the Delete key. If the entire image is selected,
click the Crop tool and then click the image to remove
the selection mask.

To cancel all changes made to the selected area and
remove the selection mask, choose Discard from the
Edit menu. But be careful! This works only while the

selection is “active.”
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Cutting, Copying, and Pasting

You can use the Cut, Copy, and Paste commands on the

Edit menu with a selected area of an image or an entire

image. The Paste as New command lets you create a new

image file from an image on the clipboard.

O

Choose Cut from the Edit menu to remove the selected
area (or the entire image if there is no selection). A
white “hole” appears where you made the cut.
PhotoPC 500 places the cut-out area on the Windows
Clipboard.

Choose Copy from the Edit menu to place a copy of the
selected area (or the entire image if there is no
selection) on the Windows Clipboard. The original

image is not affected.

Choose Paste from the Edit menu to paste an image
from the Clipboard into the active image. You can drag
the pasted area with your mouse if you want to move
it.
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[J  Choose Paste as New to create a new file from an
image on the Clipboard. PhotoPC 500 displays the new
image file in its own window, and you can save it or
add it to an album.

Cropping

Cropping an image is the opposite of cutting; instead of

removing the selected areaq, cropping removes everything

outside the area. Follow these steps:

|
2

Click the Crop tool. :ssl?;

Click and drag to select the part of the image you want
to keep. When you release the mouse button, an

animated rectangle surrounds the selected area.

Click outside the selected area if you change your
mind or want to start over. When you move the mouse
pointer inside the selection, it turns into a pair of
scissors. Click inside the selection to “cut away” the rest
of the picture.



Resizing

You can use the Resize tool to enlarge or reduce a selected

part of an image. Then you can use the resized area like

any other selection—by cutting, copying, or pasting it, and

so on. To change the size of an entire image, use the Image

Size command on the Edit menu.

Resizing a Selection
Follow these steps:

1
2

Click the Resize tool &

Click and drag on the part of the image you want to
resize. When you release the mouse button, an

“animated” rectangle surrounds the selected area.

Click and drag a corner of the selection to change its
size. The selected area “floats” on top of the original
image; you can move it by clicking inside the selection

and dragging it with your mouse.

To remove the selection mask, click the Crop tool and

then click the image outside of the selection.

Resizing an Image
When you change the size of an image, you have several

choices to make:

0

You can keep the aspect ratio (height-to-width
proportion) of the original or change it.

You can set an exact size for the image’s height or
width (or both) in pixels. Or, you can set a percentage
of enlargement or reduction.

You can change the image’s resolution (up to 1200 dpi

or more, depending on your computer’s memory).

Follow these steps to resize an image:

1

Choose Image Size from the Edit menu. A dialog box

like the one on the next page appears.

Click to uncheck Keep Aspect Ratio if you want to
change the height-to-width proportion. Leave it
checked if you want to keep the proportion.
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3 Enter new values for the size or percentage of

enlargement or reduction.

= Image Size

Width: 480 |Pixels WScale: 100 %
Height: | 348 | Pixels HScale:{100 |%

Resolution: 120 | dpi Data Size: 490 KB

Original Image Info:

Width: 480 Pixels

Height: 348 Pixels

Resolution: 120 dpi Cancel I

4 Enter a value for the image’s resolution (dots per inch).

PhotoPC 500 will keep the image the same size and
interpolate a higher resolution.

5 Click OK to apply your changes to the image.
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NOTE

To maintain image quality when printing, you should try increasing
the resolution when you enlarge an image. For example, if you scale
a picture by 300 percent (3 times larger), you should increase the
resolution from 152 dpi to 456dpi.

Rotating

You can use the Rotate tool to tilt or turn a selected part of
an image. To rotate an entire image to the exact degree you
want, use the Rotate command on the Edit menu.

Rotating a Selection
Follow these steps:

1 Click the Rotate too]é_ﬂ

2 Click and select the part of the image you want to
rotate. When you release the mouse button, an

“animated” rectangle surrounds the selected area.



Click and drag a corner of the selection to rotate it. The Rotating an Entire Image

selected area “floats” on top of the original image; you You can use the Rotate command on the Edit menu to
can move it by clicking inside the selection and rotate either a selected area or an entire image. With this
dragging it with your mouse. command, you can even set the exact degree of rotation.

Follow these steps:
To remove the selection mask, click another tool such P

as the Select tool or the Crop tool and then click the T Choose Rotate from the Edit menu. The following list
image outside of the selection. of choices appears:
= PhotoPC 500 - [cp ipal KK
Undo Ctri+Z
Cut Ctri+X
Copy Ctri+C
Paste Ctri+V
Paste As New
Discard Del
Flip »
Rotate Left 90 Deg
" 180 Degree
Image Size... F2 Right 90 Deg
Stitch... Degree...

2 Choose the angle you want, or choose Degree to

iew 11 | 490K, 24-bit RGB Color 7 B | Dragthe handle to rotate; insidetomove. : :
VRS SRReR Caar oS (1S5 2800 rea e e foetate naseta display the Rotate dialog box, shown on the next page.
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;| Rotate

@ Degree:

270 Cancel

LI
[_goncnt ]

3 Enter the exact degree of rotation in the box or drag
the dial.

4 Click OK to rotate the image.

Flipping an Image or Selection
You can use the Flip command on the Edit menu to reverse
or “turn over” a selected area or an entire image. This is

useful for applications such as printing a T-shirt transfer.
Follow these steps:

T  Select the area you want to flip, or make sure no area is
selected if you want to flip the entire image.
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2 Choose Flip from the Edit menu, and then select

Horizontally or Vertically. Your image or selection is

flipped.

3 If youflipped a selected areq, click the Crop tool and

then click the image outside of the selection to remove

the mask.

original flipped

Converting Image Types

Converting images gives you the maximum flexibility for
editing, displaying, and printing your pictures. Keep in
mind that changing an image’s data type is permanent.



The image may lose information when it is changed to a
different type, so you should always keep your original file

and use the Save As command to create the converted file.

Five image data types are available on the Convert menu:

Convert
To 1-bit Black-White
To 8-bit Grayscale
To 4-bit Index 16 Color
To 8-bit Index 256 Color

To 24-bit RGB True Color

[0 1-bit black-and-white
This type of image is like a drawing with no shades of
gray. You must convert black-and-white images to
grayscale if you want to use PhotoPC 500
enhancements or special effects.

O 8-bit grayscale
This type of image contains 256 shades of gray, like a
black-and-white photograph. You can use most
PhotoPC 500 tools and commands with grayscale
images. If you want to print a color image with a

black-and-white printer, you should convert it to

grayscale first. This makes the image file smaller

(in KB) and faster to process.

4-bit indexed 16-color

Some older VGA monitors and software applications
can display only 16 colors. Use this data type for images
that may be viewed on low-resolution systems or used

with older software.

8-bit indexed 256-color

Some Super VGA monitors and software can display
only 256 colors. Use this data type for the best image
quality on low-resolution systems or with some

software applications.

NOTE
PhotoPC 500 special effects and some other features don’t

work on indexed color images.

24-bit RGB True Color (over 16 million colors)
This type of image provides the most accurate color
and gives you the most options for editing and

enhancing in PhotoPC 500. You can convert your
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indexed color image to this type for editing purposes.
The image will appear the same, but you will be able
to use all of the PhotoPC 500 features with it.

Below is an example of an image that was originally

converted from 24-bit color to 8-bit grayscale and then to
1-bit black-and-white.

8-bit grayscale 1-bit black-and-white

See page 6-7 for information on printing your converted

images.
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“ / ou can fine-tune your images and create unusual Using Enhancement Tools and Special Effects
results using the special effects available in your In the PhotoPC 500 workshop, there are several options for
PhotoPC 500 software. This chapter describes the following: enhqncing your images and for Qdding Speciql effects. All of
0 Using enhancement tools and special effects the tools for enhancing and adding special effects follow
o ' similar procedures. Follow these guidelines when using
[J  Adjusting brightness and contrast these features in PhotoPC 500:
[J  Adjusting hue and saturation
[J  Slide the control to the right to increase the effect or
[J  Setting tone adjustment .
enhancement you are using.
[J  Sharpening images .
[J  Slide the control to the left to decrease the effect or
0 Blurring images enhancement you are using.
[ Using special effects ] If you want to see a specific area of your image
[0 Using the matte template enlarged in the Before and After windows, click the
] Using the calendar template Pan Mode box.

Using Other Features in PhotoPC 500 §-1



[J If you want to cancel any enhancement or special
effect, you can choose Undo from the Edit menu at any
time, even after you click OK.

NOTE

To use the enhancements or special effects, your images must be in

either the grayscale or 24-bit color data type. See page 7-10 for

information on converting images to these types.

Adjusting Brightness and Contrast

You can adjust the brightness and contrast of an entire

image or a selected part of an image. Follow these steps:

1

Select the area you want to change, or make sure no

area is selected if you want to change the entire image.

Click the Brightness button

1
S
=)

or choose Brightness

and Contrast from the Enhance menu.

Select the color channel you want to adjust. To adjust

the brightness and contrast of all the colors, select RGB.
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The Brightness and Contrast dialog box appears:

. Brightness and Contrast

Brightness: -14
Rl [ i
Contrast: 49

rl A _B

Channel: I-FM"@?

C RGB
 Green
 Blue 4|Qancel

Slide the Brightness control right to lighten the image,

or left to darken it.

Slide the Contrast control right to increase contrast, or

left to decrease it.

Click OK when you are finished.



NOTE
You can make similar enhancements, with finer control, by choosing
Tone Adjustment from the Enhance menu. See page 8-4 for more

information.

Adjusting Hue and Saturation

Hue and saturation describe the color values and intensity
of an image. Picture a color wheel like the one you used in
art class, with all the colors of the rainbow arranged in a
circle. When you change the hue of an image, all the colors

are shifted by the same degree around the circle.

You can adjust the hue and saturation of a selected area or

an entire image. Follow these steps:

1  Select the area you want to change, or make sure no

area is selected if you want to change the entire image.

()
2 Click the Hue tool 6@

Saturation from the Enhance menu.

or choose Hue and

3 The Hue and Saturation dialog box appears:

= Hue and Saturation

Before

[] Pan Mode

Cancel

4 Slide the Hue control right or left to modify colors.
Sliding it all the way to either side shifts the colors 180

degrees around the color wheel.

5 Slide the Saturation control right to increase intensity,

or left to decrease it.

6 Click OK when you're finished.
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Setting Tone Adjustment

The Tone Adjustment option works like Brightness and

Contrast, but it gives you more control. You can adjust the

brightness of three tone ranges in your image or selection:

the highlights, the midtones, and the shadow areas.

Follow these steps to set tone adjustment:

1

Select the area you want to change, or make sure no

area is selected if you want to change the entire image.

Choose Tone Adjustment from the Enhance menu. The

Tone Adjustment dialog box appears.
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Tone Adjustment

The mapping curve, which initially looks like a straight
line, shows the tone adjustments you make. The
horizontal axis represents the original brightness level
(from the dark on the left to the bright on the right),
and the vertical axis represents the new brightness
level.

The histogram represents the brightness of the image
or selected area. The horizontal axis represents the
brightness level (from the dark on the left to light on
the right), and the vertical axis represents the number

of pixels.



3 Click Auto to have PhotoPC 500 make the tone Follow these steps:
adjustment automatically. You can see the mapping
o T  Select the area you want to change, or make sure no
curve change to reflect the modified image. . . o
area is selected if you want to change the entire image.
4 Slide the Highlight control right to expand the

o ) ) . 2 Click the Sharpen buttor or choose Sharpen from
highlight area. This also increases contrast in the

the Enhance menu.
midtones. Slide the control left to reduce the highlight

area and darken the image. The Sharpen dialog box appears:

5 Slide the Midtone control right to lighten the midtones

or left to darken these areas. Adjusting the midtones

(also known as gamma value) does not affect the

highlights or shadows. Effect
95
6 Slide the Shadow control right to reduce the shadow
area and lighten the image. Slide it left to expand the [

shadow area and darken the image. This also increases Before

contrast in the midtones.

7  Click OK when you're finished.

Sharpening

You can use the Sharpen tool to give your image a more After

focused look, with clearer edges.
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3 Slide the control to increase or decrease the sharpening
effect.

4 Click OK when you're finished.
Blurring

You can use the Blur tool to give your image a softer, less

focused effect. Follow these steps:

T Select the area you want to change, or make sure no

area is selected if you want to change the entire image.

2 Click the Blur button |&==| or choose Blur from the

Enhance menu. You see the blur dialog box.

3 Slide the control to increase or decrease the softening
effect.

4 Click OK when you're finished.
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L] pan Mode

Cancel




Using Special Effects

PhotoPC 500 special effects let you transform your images.

You can create abstract or surrealistic art, design wild and

colorful patterns, or turn portraits into caricatures. The best

way to learn about using special effects is to experiment—

so have fun with them!

Follow these steps:

1

Select the area you want to transform, or make sure no

area is selected if you want to change the entire image.

Click the Effects browser button % or choose

Browser from the Effects menu. The Effects Browser

dialog box appears, as shown on the right.
Choose the effect you want.

Slide the intensity control to increase or decrease the

intensity of the special effect.

Click OK when you're finished, examples of some of the

effects are shown on the next page.

Effﬂct'“ Browrer

Before

i

After

y

Effect: i(,one E
Intensity 50
[« [+

[] Pan Mode

[ox |

For even more unusual results, try combining two or more
of the effects listed below.

Painting
Sketch
Film Grain
Splash
Melting
Ripple

Wrinkle Cone

3D Grid Sphere
Mosaic Whirlpool
Emboss Spiral
Motion Blur Cylinder
Fisheye Ribbon
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Fisheye

Mosaic

Using Other Features in PhotoPC 500

Emboss

Ribbon

Wrinkle

Sketch

Whirlpool

-

Ripple



Using the Matte Template
You can use the Template feature to create a framed
picture with personalized text. Choose from 9 attractive

backgrounds to design your printout.

NOTE

Before you use the Template feature, make sure your printer is set
up correctly. (You must have a printer driver installed to use a
Template.) Choose Printer Setup from the File menu to check the
settings. The Paper option for EPSON Stylus® printers should be set
to 8 1/2 x 11, centered. See your printer documentation if you need

more information.

Follow these steps to get started:

1  Click the Template button.

The Template dialog box appears.

double-click double-click to click to select
to change add image orientation
background
=.| \ Template
A\
AY [ Template:
[ETS—
rientation:
® Portrait
Landscape
Photo Size:
Double click \Widtit 4.0 Inch
0in
to open photo Height: 5.4 Inch
pe [ |
Draw Frame
[pouble ek T editex] e

double-click  click arrows / keep checked type
to add text or slide bar to  toadd frame  number of
change image copies

If you have an image open, it appears in the dialog box

window.
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Click the down arrow to select Matte, if it’s not already

selected.

If your screen is not displaying the image you want to
use, double-click the gray rectangle or existing picture.

A file selection dialog box appears.

Select your picture file and click OK. The image

appears in the center of the page.
Choose Portrait or Landscape page orientation.

Drag the slider if you want to change the size of the

image.

When you leave the Draw Frame box checked,
PhotoPC 500 draws a line around your picture. If you
don’t want a line around the picture, click Draw Frame

to remove the checkmark.

Click and drag your image to place it where you want.

Adding Background

You can add a custom color background to your picture or

choose from 9 patterned backgrounds.
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NOTE
Your picture takes longer to print with a colored or patterned

background.

Follow these steps to add a background:

Double-click the background. The Template
Background dialog box appears:

— Template Background

Background: | Change Color...
coor

oK | cancel

2 Click the down arrow to choose a color or a pattern.

If you click one of the pattern names (such as Birthday
Party or Sports), the pattern appears in the window,
behind your picture.



3 To choose a color, select Color on the list of pattern

names, and then click the Change Color button. The

Color dialog box appears:

= Color

Basic Colors:

B 10 .

A .

Custom Colors:

N [ () N I O
[ I ]

| Define Custom Colors... I

| OK I | Cancel I

4 Click one of the basic or custom colors, or click Define
Custom Colors. (See page 5-9 for information about

defining a custom color.)

5 Click OK twice. The color you choose appears in the

Template window, behind your picture.

Now you can add some text, or just print your framed

picture. See page 8-13 for printing instructions.

NOTE

The PhotoPC 500 imaging software creates your matted picture
with opaque layers. The background is the bottom layer, your
picture is the middle layer, and any text you add is the top layer.
You can even have the text print on top of your picture. Feel free to

experiment to get the effect you want.

Adding Text
You can add one or two blocks of text to your matted

picture, designed any way you want. Follow these steps:

T Double-click one of the text boxes. The Edit Text dialog

box appears:

= Edit Text
|

[font. | [_ox | [cance |
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2 Type your text.If you have more than one line of text,
press Enter to start a new line. (Although text appears
to wrap automatically as you type, it wraps on your

printout only if you press Enter.)
3 Click Font. The Select Font dialog box appears:

= Select Font

Font: Font Style: Size:
. T

Regular
Arial (4] R a
r Arial Rounded MT Bold =]

.
>

[2]
g
g
g

Italic 18

T Bookman Old Style Bold 20 [ |
*r Braggadocio Bold htalic 22
 Britannic Bold o fea
Effects Sample

[ strikeout

[Junderline AaBbeZz
Solor

This is a TrueType font. This same font will be used
on both your printer and your screen.

4 Choose your font, style, size, color and any effects you
want. The Sample box shows you how your printed
text will look. Remember that the text prints over the
background you select. If the background is dark, you

should choose a light color for the text.
5 Click OK when you're finished.

6 Click OK again on the Edit Text box when you're
finished typing your text.

8-12 Using Other Features in PhotoPC 500

If you want two blocks of text on your page, repeat
steps 1 through 6 for the other block of text.

You can drag the blocks around the screen to place

them where you want.

Here’s what a finished matte template might look like

on your screen:



Printing Your Matted Picture 2 Click the down arrow to select Calendar, if it’s not

When you finish designing your matted picture, you can already selected.
print it. Follow these steps:
1 Enter the number of copies you want to print. (This [lSmelate:

Calendar E

Orientation:

option is available only if your printer supports it.)

2 Click Print. @ Portrait
O Landscape

3 When you're finished, click Exit. Photo Size:

ouble click Wi 4.0 nch
While PhotoPC 500 is open, you can reuse the template t open photo Heigt: 54 inch
with another image and background, and different text. (<[ -]

. . X Draw Frame

Just click the Template button and start creating.

Copies: E

Using the Calendar Template

You can create a personalized calendar using a different

picture for each month. Then you can add a colored or click and drag photo, text, and calendar

. . . boxes to move around on template
patterned background, a title or caption, and design the P

dates in any size, color, and style you want. . .
y yiey 3 If the screen doesn’t display the image you want,

Follow these steps: double-click the gray rectangle or existing picture. A
file selection dialog box appears.
1 Click the Template button The Template dialog
box appears. If you have an image open, it appears in 4 Select your picture file and click OK. The image
the window. appears in the center of the page.
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5 Choose the Portrait or Landscape page orientation.

6 Drag the slider if you want to change the size of the

image.

7  When you leave the Draw Frame box checked,
PhotoPC 500 draws a line around your picture. If you
don’t want a line around the picture, click Draw Frame

to remove the checkmark.

8 Drag your image if you want to change its position on
the page.

Adding Background and Designing the Dates
You can add a custom-color background to your calendar
and choose from 9 patterned backgrounds. Then you select

the month and year, and design the date portion.

NOTE

PhotoPC 500 creates your calendar with opaque layers. The
background is the bottom layer, your picture is the middle layer,
and the dates are the top layer. If you add text, it appears on top of
all other layers. You can experiment with these elements to get the

effect you want.
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Follow these steps:

T Follow the steps on page 8-10 to add a colored or
patterned background.

2 Double-click the calendar month displayed on the
Template screen. The Edit Calendar dialog box
appears:

= Edit Calendar

Font... I

Month: |July

Year: +

1

3 Click the down arrows and select the month and year

you want.

4 Click Font. The Select Font dialog box appears, as

shown on page 8-12.

Choose your font, style, size, color, and any effects you
want. The larger the font, the more space the dates
occupy on the page. The Sample box shows you how

your printed dates will look.



7

Remember that the dates are printed over the
background you select (or over your picture, if you
want). If the background is dark, you should choose a

light color for the dates.
Click OK when you're finished.

Click OK again on the Edit Calendar box. The dates

appear on the page with your image.

Drag the date box to position it where you want.

Adding Text and Printing the Calendar
When you finish designing the picture and dates, you can

add a title or caption, and then print your calendar page.

Follow these steps:

1

Follow the steps under “Adding Text” on page 8-11 to
add a title or caption. (The calendar has only one text
box.) When you're finished with the text, you see
something like the following on your screen:

You're ready to print.

Enter the number of copies you want to print. (This

option is available only if your printer supports it.)
Click Print.

Click Exit when you're finished.
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After you complete the first calendar page, you can
continue with the next month and make a calendar for the
whole year. Or you can create a new calendar page each

month.
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—7\ Inserting Pictures into Documents

When your images are saved in albums or on your
hard drive, you can insert them in your documents

LYl Campus

State Community College Newsloner / Vol 2
Fall Semester by copying and pasting, or importing them. You can use

isier Now for

your pictures in applications such as word processors,
presentation programs, database managers, spreadsheets,
page layout and desktop publishing packages. This chapter

explains how in the following sections:

New Auwditorium Sef to Open

After three years of construction, the Smith
Memorial Auditorium is finally set to open

il hetd e s ek ol [J  Inserting pictures with Windows 95
iyt oget o cone n ey o et . . ) )
wming O Inserting pictures with Windows 3.1

Several plays will be held in the auditorium

this winter including How to Become . . .

ilinsit s Py Hous. He e [ Using copy and paste to insert a picture
available at the Student Union or at the ficket

booth.

NOTE

You can also transfer images directly from the camera into

Inside Tieis Issue

documents with drag and drop or by inserting them as objects as

described on page 4-5.
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3 Select Picture from the Insert menu. (In some

NOTE
) ) ) applications you may need to select a different
If you want to change a picture before you insert it, you can use the

command, such as Import, which is often found in the

Photo PC 500 imaging software to crop, rotate, resize, or make . . X
File menu.) An Insert Picture dialog box appears:

other types of enhancements. (After you insert your picture, you

Insert Picture

can use your application to change the size and position of your

Lookin |4 Photos
picture.) For more information on using the PhotoPC 500 imaging Narme oK
= Birdls jpg
software, see Chapters 4, 6, 7, and 8. s | x|
Advanced

Evening.jpg
El

I~ Link To File
F Saus with
Document,

g
[ 0c11_008,jog
Painting jog

Inserting Pictures with Windows 95

Follow these steps to insert your PhotoPC 500 pictures with e
Windows 95 or Windows NT 4.0: esse | ] T | o nen |
Files oftype: [l Graphics Files (*brmp:"wit* pox | Lastmodified:  [any time =] Newsearch

11 file(s) faund

1T Open the document you want to add a picture to in

your application.
4 Find the file you want to insert. Most of your pictures

2 Select the point where you want to insert your picture. are probably in C:\PHOTOPC5\PHOTOS. In some
applications, such as Microsoft Word 7.0, you see a

preview of your picture.
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NOTE

You can conduct a search to find your file in many applications
designed for Windows 95. You can search by file name, type,
text or property associated with the file, or the day your file
was last modified. You can also conduct an advanced search.
See your application’s documentation or help for more

information.

W Microsoft Word - Do

Click OK to insert your picture. The picture appears in

your document

Add a frame, if you want, so you can move your

picture around on the page and resize it if necessary.

™) File Edit View lhset Fomat Tools Table Window Help =
_I_I_IQIEILI_I%IEM_LI“'_LI“'E ERiER J’W"I
Body Text =]/ [Times NewRaman Blz|u|a-|EEEE =

Volume 1 Issue 1 December 1996

EE=
NEEREEEEE VYRR S E = ENEEN = =)

Daouble-click to edit
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Inserting Pictures with Windows 3.1

In Windows 3.1, Microsoft Word and other applications are
often unable to recognize the JPEG format that the camera
uses to capture your pictures. Convert your picture to a Tiff
or bitmap file in PhotoPC 500 as described on page 6-8 or
export your photo in the bitmap format as described on
page 4-11. Then, follow these steps to insert your converted
PhotoPC 500 pictures into documents using applications in
Windows 3.1:

T Open the document in your application.

2 Select the area of your document where you want to

place the picture.

3 Select Picture from the Insert menu. (In some
applications you may need to select another command
such as Import, which you can usually find in the File

menu.)

9-4 Inserting Pictures into Documents

57;=-i- Insert Picture
ﬂi!m Directories: i =
[lake.bmp G\Dhotmc'-i\ms e
Bet |
Bphuopos |
ol
: [Qc medos I
List Files of Type:
—= | Link to File [X Preview Picture
|A“ Eisince rdes J [x Save Picture in Document
[ ok || concel | | FindFile.. | Newak.. | | Hew |

The Insert Picture dialog box appears:

Find the file you want to insert. Most of your pictures
are probably in C:\PHOTOPC5\PHOTOS. If you
converted the file, look for the file in the directory
where you saved it. In some applications, such as

Microsoft Word, you see a preview of your picture.

NOTE
You can conduct a search for your file in many Windows
applications. See your application’s documentation for more

information on conducting a search.




5 Click OK.

The picture appears in your document:

= Microsoft Word - DOCZ.D0C '|=
-| File Edit View Insert Format Tools Table Window Help

D) S ¥] [ %] o] o ¢ _QIEJJIEI_HIGAILJWLJLEEI
[NOIMl ]lhmsﬂennumn E;TE BIII]}_I = !!’I-I :I = Eﬁﬂl:‘

D 3| EE|EI E|D|EEI|E§|EIFT:L:7 - 7":[[
\n._w---n-‘-g- ' [ =3 o er

Monday, Ociober 28, 1996

? This is the view you will have from

H your lovely lakeside condomsinizm.

: !
: £
| E_QI:_—E
NEEIREEIEEEN VB RS L L N N e = =E

Using Copy and Paste to Insert a Picture

Follow these steps to insert a PhotoPC 500 picture into your

document using Copy and Paste:

1

AW

Open your image in PhotoPC 500 or other image-
editing application.

Click the picture (or choose Select All) to make sure it is
selected.

Select Copy from the Edit menu.

Start your word processor or other application and

open the document where you want to use the picture.

Choose Paste or Paste Special from the Edit menu. A

copy of the picture appears in your document.

Inserting Pictures into Documents 9-5



/JTO \ Creating Projects with Print Artist

P rint Artist is a great tool for creating all kinds of
projects such as newsletters, greeting cards, flyers, and
business cards. It allows you to combine your pictures with
text and add any of the hundreds of clip art graphics that
come with the program. You can customize graphic
elements, lettering styles, and colors, and even use images

that you've transferred from the camera.
This chapter describes the following:

Getting started with Print Artist
Creating a greeting card
Importing an image

Finishing the card design

Saving the card

O o o o o d

Printing the card and exiting
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Getting Started with Print Artist

Print Artist is easy and fun to use. With a little practice, you

may even discover some new talents in graphic design. = valack oocament Type

Follow these steps to get started:

T In Windows 95, click Start, point to Programs, and then

point to Sierra. Click the Print Artist icon. St
LETTERHEAD CERTIFICATE

From the Windows 3.1 Program Manager, double-click @ o

the Print Artist icon in the Sierra Group. i] GREETING ETy L

() CARD BANNER
You see the Document Type screen, as shown to the

. =] ENYELOFE
right. Eoso >

(@

2 Click the type of document you want to create, and

then click New.
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You see the following screen:

I=| Select New Greeting Card

Categories:

Occasion
Event
Announcement
Retail
Sentiment

Layouts:
Solo Graphic
Solo Text

Mowochome  [Fow —[3]

rZ =

(If you choose greeting card or calendar, you first see a
preliminary dialog box. For more information about
creating a greeting card, see page 10-4.)

Choose your category from the list.

The three main categories give you three different
starting points:

[J  Choose one of the descriptive categories if you
want to start with a predesigned layout. This is a
great way to start if you've never designed a
document before. Most document types have

many attractive layouts to choose from.

[ Choose Templates if you want to start with
defined areas for text and graphics. For most
documents, you can choose from several

templates.

0 Choose Blank if you want to start from scratch.
Depending on the type of document, you can

choose from several layout sizes.

Choose your layout and click OK. The Print Artist main

screen displays the starting layout.

From here, you can click the various objects in your
document to select them, and use all the tools, palettes,
and menus to design your project. You can move the
objects around, add photos, and modify the text and
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graphics to create your own personalized document. If
you need more information while working with Print

Artist, you can use the Help menu or press the F1key.

The rest of this chapter shows you how to create a greeting
card with your PhotoPC 500 images. But this is just a start.
Feel free to experiment with Print Artist and explore the

creative possibilities.

Creating an Invitation

It's easy to create a professional-looking invitation using
one of the predesigned layouts. You can add your own
picture, then decide whether to write your own message or
use Print Artist’s wording. When you finish this quick
lesson, you'll have a personalized invitation to an open

house.

Follow these steps to choose a colorful layout and get ready

to add one of your pictures:

1  Start Print Artist as described on page 10-2.
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2 Click Greeting Card, and then click New. The Greeting
Card Fold dialog box appears:

+ Tall Side-Open Card
Tall Top-Open Card
Wide Side-Open Card
Wide Top-Open Card

v « ‘x&nwl [ ?Hebl

3 Click Tall Side-Open Card and click OK.

4 Choose the Category and Layout you want to use. To
make a personalized open house invitation, choose the
Open House Layout from the Occasion Category. The

layout appears in the window, as shown on the next

page.



Select New Greeting Card

Print Artist - Uniitled

File Edit View Insert Object Font Effect Color Shape Alignment Help

=nj=(als| TS0l FEHEMS

A Star is Born
Baby. Gift From Heaven
Baby, It's a Boy

Baby. It's a Girl

5 Click OK. The front of the card appears on the main

Press your Delete key to delete it. Now you have just
screen, as shown to the right.

the text. See the next section to add the photo of a
house.
6  Click the graphic element to select it (the house).
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Importing an Image

When you import an image, Print Artist copies the image
file into the directory or folder where other image and art
files are located. Then the picture is available to use with
other Print Artist projects. Follow these steps to import an

image:

T  Choose Import from the File menu. The Import dialog

box appears as shown:

- Import

Document Name: | irectosies:
GBOBI 01 jpg || etsienatpa

apr12_D5.jpg
house.ipg
juni_ 0. jpg
“whitehs. ipg

| List Files of Type: - —
JPEG  Cipa) 8] || BeviemCriphic 3]

(V] (3] [20]

2 Make sure JPEG is selected under List Files of Type. (Or
select a different file type if the picture you want to use

is not saved in the JPEG format.)

10-6 Creating Projects with Print Artist

3 Double-click the Directories box to display the

directory list. Then double-click the directory or folder
containing your PhotoPC 500 images. (The default is
C:\PhotoPC5\Photos.)

Locate the picture you want. You can click the Preview
Graphic button to check if you have the right picture.

Double-click the image file you want to use. The

picture appears on the front of your card.

=T Print Artist - Untitica™ =
File Edit View [nsert Object Font Eflect Color  Shape  Alignment Help

DRECCENREEEEIEEEEE HIE

g




Adjusting the Text
You can adjust the appearance of the text so that it looks

better with your graphic by following the steps below:

1
2

Click the text to select it.

Move the mouse over the center of the text. Your

pointer will turn into a hand shape.

Click and hold the mouse to move the text to the top of
the card.

Use the corners to resize and realign the text. The

words are sized to fit the selection area as shown.

Changing the Text and the Font
If you want to change the font on your card, follow these
steps:

T Double-click the text. The Change Text window

appears, as shown below:

2 Type new text if you want (or click Quotes to choose
from some famous quotations) and click OK to return

to the main screen.

3 With your text selected, click the Font palette button.
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The Font palette appears.

= Print Artist- Untitied” =]
=] Fonts File Edit View Insert Object Font Effect Color Shape Alignment Help
Rigerian T NmECIEEEEEEEE =EIHIE
Arial =
Arial Bold
Arial Bold Italic
Arial Italic 9
el Founded MT old WERE HAVING
Bahaus
Bookman Old Style Bol, AN OPEN HOU$E
Bothell L
Braggadocio + ']
_| Plain
| htalic
| Tilted
| Wacky
_| Staggered

4 Click the font you want to use. Your text changes if you

browse through the fonts. You can move the Font T slected [Poston: 213X 275"

palette if you can’t see your text.

N

Click and drag one of the corner handles to enlarge the
Adding a Background Fill color block.

After you finish working with the text, you can add a

W

colorful background to the front of the card. Follow these Click the Color palette button.

steps:

T  Click the yellow Insert Fill button. A square block of

yellow color appears on the card, as shown below.
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The Color palette appears:

— Colors
Custom

Giey, Black Hange
Black

Black and White
Purple

Cyan

Green

ellow

Orange

Magenta

| Background

Click the color you want to use. Then click the Color
palette button again and select Lightened. Click

customize if you want to experiment with color.

While the background is still selected, choose Send to

Back from the Object menu.

Object
Bring to Frent
Send to Back
Bring Forward Alt+Grey +
Send Backward Alt+Grey -
Maximize Ctri+M
Shrink to Fit

Center Horizontally
Center Vertically

Align Horizontally

Align Vertically
Group Ctrl+Y
Ungroup Ctrl+U

The background appears behind the picture and the
text.

= Pt Aist - house
Eile Edit Yiew Insert Object Font FEMect Color Shape Alignment Help

| Dl=[w[a] TIelnkE EEial == =15 1 2
WERE HAVING AN |
OPEN HOUSE

Adding a Graphic
You can add a graphic to change the look of the inside of

your card. Follow these steps:

1 Click the gray shadow to “open” the card or choose
Inside Right from the View menu. You see the inside
right panel.
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2 Double-click the graphic to change it.
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The Graphics Grabber dialog box appears:

House Icon
House, Ranch
House. Suburban

House, Victorian
House, Victorian 1
Playhouse

Type House in the Type Search Text box. The Graphics
box lists the available House pictures. When you select

a picture, it appears in the window.

Select the graphic and click OK. The inside panel of the
card displays the graphic.



5 Select Vertically Stretched from the Alignment menu.

=] Print Artist - Untitled™ ME
File Edit View Insert Object Font Effect Color Shape | Alignment Help

= 2 ] =[= Left
= n|=(.|a| TISIOIR FElEME] = =V Horizontally Centered

_ Right

Letter Justified
Word Justified
T Horizontally Stretched
FORTO T O e,
TIME TOVErIRL 1D Vertically Centered

Bottom

Vertically Justified
+ v Vertically Stretched

Tae %s‘sss—m Word Wrap ‘

Extra Letter Spacing [ space)
Extra Letter Spacing (% space)
Extra Line Spacing % line)
Vertical

&

S |

Align to left border. Position: 2.07 "X 263"

This allows you to stretch the graphic to fit around the
text. (The default for alignment is vertically and
horizontally centered, so graphics can be made smaller

or larger, while keeping the same proportions.)

6 Drag the corner handles to make the graphic large

enough to fit around the text as shown above.

7  Change the inside text and font as you did for the front
of the card. You can change the graphic in the center of

the text as well.

Now you can save and print your card.

Saving Your Card
When you're finished designing the card, follow these steps
to save it:

T Click the Save button. The first time you save your

card, the Save As dialog box appears:

= Print Ariist - Untiicd” HE
File Edit View Insert Object Font Effect Color  Shape Alignment  Help

& Dlzlrlal TIeOE EEvial ===== ]
= Save As )

Descriplive Name:  Open house announcement

| File Name: [Dmectonies:
house.gc o \zenrahpa ‘
SIERRA
PA ‘
|
[ListFiles of Type: | Drives: m
Greeting Cards (*ge) | #] | | &5 o msdos 3]

2 Type a descriptive name (up to 32 characters) for your

project.
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3 Type a file name up to 8 characters long. Print Artist
automatically adds the .GC extension (for greeting

cards).

4 Click OK when you're finished.

Printing Your Card and Exiting
After you save the card, you're ready to print it. Follow

these steps:

1 Click the Print button. The Print Control Panel/

Preview window appears:

=\ Print Control Panel { Preview

Epson Stylus
COLOR 500, output

on LPT1:

s 75 =
Height[99 | e
Pages / Copy: 1
Percent Size: M%ﬂlfn

o 23]
Piint: Document | #| Z\l

nan
Copies: [1 ]E gr:z:"%”g
+ A =

d FPages

\ Click and drag to puulm document.

| Eance!l *Selupl | Area

Print
.,..u"m| | ? het |
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2 Adjust printing options if you want and click OK to
print your card.

3 Fold the printed greeting card, and it’s ready to deliver.

4 When you're finished using Print Artist, choose Exit

from the File menu.

If you liked making the card, you can try making a
personalized envelope to go with it. Or use your saved
pictures to make personalized business cards, signs,
banners—even party hats and other folded paper craft
items. For Print Artist technical support, call (206) 644-4343.



/]" \ Using the Optional LCD Monitor

l After you take your pictures, you can play them back
on the PhotoPix LCD Monitor. If one image isn’t
perfect, you can erase it and take another one. You can also

select any picture you want to erase.

This chapter explains how to use the PhotoPix LCD Monitor
in the following sections:

Getting to know the PhotoPix LCD Monitor

Attaching the LCD monitor to the camera

Saving power with auto shut-off

Using Playback Mode
The EPSON PhotoPix LCD Monitor (A883051) should be
available where you bought your PhotoPC 500. You can
also order it from EPSON Accessories at (800) 873-7766 (US.
sales only). In Canada, call (800) 463-7766 for dealer
referral

Using View Mode to take pictures

O O o o o od

Detaching the PhotoPix LCD Monitor
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Getting to know the PhotoPix LCD Monitor

The PhotoPix LCD Monitor’s features are shown below.

Multi - button 4 putton

release button

Macro

power
switch

LCD
connector

display screen

Attaching the LCD Monitor to the Camera

Make sure your camera is turned off and follow these steps
to attach the PhotoPix LCD Monitor to the camera:

T Locate the LCD inlet cover on the back of your camera.
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2 Pressing on the arrow with your thumb, slide the cover

away from the camera in the direction shown.

NOTE
Place the cover in a safe place like a camera bag or a plastic

baggie. It is small and can be lost easily.

3 Make sure the LCD Monitor’ s mode switch is in the OFF

position.

4 Place the LCD Monitor so that the display will face you

when you take a picture.



5  While holding the camera with one hand, carefully [0 When the PhotoPix LCD Monitor is in Playback mode,
slide the LCD Monitor connector into the LCD inlet. it shuts off if it is not used for 5 minutes.
Make sure it is firmly in place. [l When the camera is turned off with the PhotoPix LCD
Monitor in View mode, a caution message appears on
the Monitor for ten seconds. Then the LCD Monitor
shuts off.

[0 The PhotoPix LCD Monitor shuts off automatically

when the camera is connected to a computer.

NOTE
Although the PhotoPix LCD Monitor includes these power-saving

LCD inlet

LCD monitor features, it uses a large amount of battery power. You may want to

connector buy an AC adapter to use with the monitor, as described in

See page 11-13 for instructions on detaching the Appendix A, or use rechargeable or lithium batteries. See page 1-4

PhotoPix LCD Monitor. for battery information.

Saving Power with Auto Shut-Off

Because the PhotoPix LCD Monitor uses additional power,
the following power-saving features take effect when it is

attached to the camera:

[ When the camera shuts off, the PhotoPix LCD Monitor

also shuts off.
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Using P|ayback Mode The camera’s control panel reads “Lcd” as shown.

After you have finished taking your pictures, you can use ' \l_ﬁf Erase icon
Playback mode to view the images, erase any images you : ,- ,-'
- ' ==

don’t want, or view several thumbnails at once. You can
. . . battery icon
also view your images as a slide show. A\\N v

NOTE The PhotoPix LCD Monitor displays the last image you
The camera does not have to be turned on to display pictures in captured with its number in the top left corner.
Playback mode. =

VIEW J\r

PLAY BACK

Turning on Playback mode
Follow these steps to turn on Playback mode:

1T Make sure the PhotoPix LCD Monitor is connected to

the camera as described earlier in this chapter.

2 Move the LCD Monitor power switch from the OFF
position to PLAYBACK.
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If there aren’t any pictures in the camera’s memory,
you will see a screen like the one below.
VIEW \

PLAY BACK

7 N

EPSON

H °00o0°
7
"

/

NOTE

You cannot use the camera’ s controls while the PhotoPix LCD
Monitor is in Playback mode. You can use the LCD Monitor to erase
pictures, but to change other settings, you must either turn off the

LCD Monitor or switch it to View mode.

Viewing other images in your camera

Follow these steps to view the other images in your camera,

one by one:

1

Turn the PhotoPix LCD Monitor on in Playback mode
as described earlier in this chapter. You see the last

image you captured on the display.

Locate the “+” and “-” buttons on the top of the LCD
monitor.

- button + button

Qopd
=

Press “-” to view the next to last image. Continue

“u_n

pressing “-” to view your images in the order of last to

first.

Press “+” to view your first image. Continue pressing

the “+” button to go from the first image to the last.
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Using Multi Mode 3 The display shows 9 images. The selected image has a
You can use this feature to view several images in small, frame around it.

VIEW \
PLAY BACK

thumbnail versions all at once. This allows you to select

and erase images or to find the image you want quickly. —

Follow these steps to view multiple images:

1  Set the PhotoPix LCD Monitor to PLAYBACK as

described earlier in this chapter.

2 Press the MULTI button on the top of the PhotoPix LCD

Monitor.

A )

(6 @ @ 4 Move the frame to select other images by pressing “+”

MACRO  MULTI or “”. As you move the selection frame, more images

f— Tl

appear on the screen.

11-6 Using the Optional LCD Monitor



2 Using a pencil or ballpoint pen, press the erase button

) on the top of the camera.

VIEW
PLAY BACK

erase
button

0000

=~

The PhotoPix LCD Monitor displays the erase icon over

the image for a moment, and then the image
/ disappears.

=~

Erasing Images
You can use the PhotoPix LCD Monitor to select images and

erase them. You might want to take a picture when the
camera is full. You can select a picture, erase it, and then

take another picture.

Erasing images in normal Playback mode

Follow these steps to erase your images while viewing them

one at a time:

T Make sure the image you want to erase is showing on jjj

the screen.
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Erasing images in Multi mode 3 Usea pencil or a ballpoint pen to press the erase button

Follow these steps to erase images while you are viewing on the top of the camera as shown on the previous
several at a time: page.
T Make sure the image you want to erase is showing on 7 . \
[ VIEW
the screen. . o pLay BACK
77 N\

2 Press the “+” or “-” buttons until the image you want to
erase is selected. The border around the image should
be highlighted.

e
J-\
l

The PhotoPix LCD Monitor displays the erase icon over

the selected image, as shown above, and then the
image disappears. The other images are renumbered

and re-ordered on the screen.
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Displaying a slide show
You can use the PhotoPix LCD Monitor in Playback mode to
play your images in the form of a slide show. Follow these

steps:

1 From normal playback mode, press the “+” button and

hold it down for five seconds.

The camera displays your photos one-by-one on the
screen. The monitor stops after displaying all the

images.

2 Tostop the slide show before the camera has displayed
all the images, press the “+” button again. The screen

stops on whatever image is currently displayed.

Using View Mode to Take Pictures
You can use this mode to see a live preview of what the
camera’s lens sees at any moment. You can adjust the

brightness and take close-up pictures in this mode.

CAUTION

View Mode uses batteries quickly. If you use this mode, it is strongly
recommended that you keep your camera on for short periods of
time. Turn off the LCD monitor immediately after you take a
picture. It is best to use lithium batteries, or rechargeable NiCd or
NiMH batteries if you are taking pictures with this mode.

See page 1-4 for battery information.

Turning on View mode
Make sure the LCD monitor is firmly attached to the
camera as described in the previous section. Then follow

these steps:

1T  Turn the camera on by sliding the power switch to the
ON position.

2 Move the PhotoPix LCD Monitor’s power switch from
the OFF position to VIEW.
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The camera’s control panel displays “Lcd” as shown:

L - ,-_" &—

“\“ y battery icon

In the LCD Viewing Screen, you see a picture of

whatever image the camera’s viewfinder is pointed at.

Gr— 1)

« OFF
. PLAY BACK

set switch to r

View

z
J\

((
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NOTES

O

The image area displayed in View mode is slightly smaller than
the area captured in the actual photo. To see the total area
captured, view the photo in Playback mode, as described on
page TI-4.

The image may appear to flicker when viewed under strong
fluorescent lighting, depending on the lighting’s frequency.
This is normal and does not indicate a problem with the

camera or the LCD Monitor.

Taking a Picture
After you have turned on the camera and the LCD Monitor,

follow these steps to take a picture:

1

Position the camera so that the image you want to

capture appears in the display.

Adjust the position of the camera if necessary. You can
use the camera’s control panel to adjust settings, as
described in Chapter 3.



The LCD Monitor shows the image in “real time,” so
what you see on the screen is what the camera’s lens

sees at any moment.

Snap the shutter to capture the image. The image
freezes on the LCD Monitor and then appears with its

number as shown.

-\

/

/

The LCD monitor returns to the view through the

camera’s viewfinder.

For more information on taking pictures see Chapter 2.

To play back the images you have captured, see “Using
Playback Mode” on 11-4.

NOTE
If you use the flash and your battery power is low, the PhotoPix LCD
Monitor will not return to live view until the flash is recharged. The

screen remains blank during this period.

Adjusting brightness

You can adjust the LCD monitor’s brightness so you can see
the image on the screen under various lighting conditions.
This does not change the appearance of your photo. Follow

these steps:

1T  Set up and turn on the PhotoPix LCD Monitor and the
camera as described earlier in this chapter. Make sure

the monitor is set to View mode.
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2 Locate the “+” and “-” buttons on the top of the
PhotoPix LCD Monitor.

[Qceé

MACRO  MULTI

3 Presseither of these buttons. The brightness control bar

appears on the display.

S

@ === PLAY BACK

~ |
L\
N /
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~

VIEW

4 Press the “+” button to increase the brightness of your

preview or the “-” button to decrease the brightness.

NOTE

The brightness level display disappears after 3 seconds if you
don’t press the “+" or “-" buttons, or if you press another
button on the PhotoPix LCD Monitor.

Taking Close-up pictures with Macro mode
You can use the PhotoPix LCD Monitor to take close-up

pictures with Macro mode. Follow these steps:

1 Set up and turn on the camera and PhotoPix LCD
Monitor as described earlier in this chapter. Make sure
the PhotoPix LCD Monitor is set to View mode.

2 Locate the Macro button on top of the LCD Monitor.

[Copé

MACRO  MULTI




3 Press the Macro button. “MACRO” appears on the 5 When you are ready, just snap the shutter.
screen for a moment and the frame around the screen

6  You can return to normal View mode by pressing the
turns green.

S

Macro button again. The green frame disappears.

’ 2

® OFF VIEW NOTE
(] PLAY BACK
7 N\ Using the flash with Macro mode may wash out the image
TITES slightly. Try taking Macro mode pictures in natural light with

the flash set to Flash Off as described on page 2-5.

T Goso

Detaching the PhotoPix LCD Monitor
Follow these steps to detach the PhotoPix LCD Monitor

from the camera:

EPSON )
\_, )/ 1  Turn the camera off, and set the LCD Monitor mode

switch to OFF.

The frame stays green as long as you are in Macro

2 Place the camera on a flat surface if possible.
mode.

With the back facing you, hold the camera with your

4 In this mode, you can capture an image within as little
right hand and the LCD monitor with your left hand.

as 8 inches (20 cm) from the subject. Get as close to the
subject as necessary and check the image in the LCD

monitor.
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4 Using your left thumb, press the release button on the 6 Replace the LCD inlet cover on the back of the camera.
LCD connector, shown below.

release button push from here

5  While holding down the button, push the PhotoPix
LCD Monitor away from the camera with your right
thumb. (It is easiest to push from the area shown to the
left)

CAUTION

Do not pull the PhotoPix LCD Monitor when removing it from
the camera. Pulling the monitor could cause the LCD connector
to break.
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)ﬁ\ Caring for the Camera and Troubleshooting

Your PhotoPC 500 camera is easy to take care of, and

any problems you may have are easy to solve.
This chapter includes the following sections:

Caring for the Camera
Caring for the optional LCD Monitor

Solving Camera Problems

O O o o

Solving Picture Problems

Caring for the Camera

Your PhotoPC 500 requires only basic care. Before you
perform any maintenance procedures on the camera, be
sure to read the Safety Instructions in the Introduction.

Then follow these guidelines:

Cleaning the Camera

u
u
u

Use a clean, dry cloth to keep the camera free of dust.
Don’t use harsh or abrasive cleaners.

To clean the lens, first blow off any loose dust or dirt.
Then breathe on the lens and wipe off all moisture

with a soft, lint-free cloth or lens cleaning tissue.
To avoid scratching the lens, don't press too hard.

If necessary, clean the battery contacts with a dry
cloth.

Storing the Camera

0

Keep the lens covered (power switched off) when

you're not using the camera.
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[0 When the camera is not used for long periods of time,
remove the batteries and store them at a low
temperature in a dry location. This prevents camera

damage from battery leaks or corrosion.
Don't store the camera in the following locations:
0 Where it will be exposed to direct sunlight, for
example, on a car dashboard
Near sources of bright light or high humidity
Near heat sources or in a closed car

In areas of excessive light or dust

O o o d

Where it will be exposed to strong vibrations or

magnetic fields

Caring for the Optional LCD Monitor

Your PhotoPIX LCD Monitor requires only basic care. Before
you perform any maintenance procedures on the camera,
be sure to read the Safety Instructions in the Introduction.

Then follow these guidelines:

12-2 Caring for the Camera and Troubleshooting

Cleaning the LCD Monitor
O Use a clean, dry cloth the keep the monitor free of dust.

0 Don’t use harsh or abrasive cleaners.

O If the monitor gets fingerprints or smudges on it, use a
soft, damp cloth to lightly wipe the screen.

0 Toavoid damaging the LCD display, do not apply too

much pressure as you clean it.

Storing the LCD Monitor
[0 Remove the LCD monitor from the camera when you
are traveling with it or if you are not using it for long

periods of time.

[J Store the LCD monitor in a camera bag or other
covering that will keep it safe from dust.
(1 Keep the monitor switched to Off when it is not

attached to the camera.

1 When the LCD monitor is not attached to the camera,
make sure the LCD inlet cover is attached.
[0  See “Storing the Camera,” above, for a list of conditions

to avoid when storing the LCD monitor.



Camera Problems
Before you call for help, check this list of problems and

possible solutions:

The camera has no power.

O

Check the power switch and make sure the camera is

turned on.

The camera may have shut off automatically. Slide the

power switch off and then on.

Check the batteries and make sure they are installed
correctly. Replace the batteries if necessary, following

the instructions on page 1-4.

If you are using the AC adapter, make sure it is plugged

into a working outlet.

You can’t take a picture with the camera.

O

The flash may be recharging. Wait until you see the
green ready light, and try again.

The camera may be full. Check the picture counter on
the control panel. Erase a picture using the erase

button, or transfer the pictures to your computer and

then erase them. See Chapter4 for information about
transferring your pictures and Chapter 5 for

information about erasing them with your computer.

The camera may be connected to your computer.
When it's connected, you can’t use any of the controls
on the camera itself. See page 5-5 for instructions on

taking pictures from your computer.

The flash doesn’t work.

U
U

Make sure the flash is not set to flash off

Check the batteries and make sure they are installed
correctly. Replace the batteries if necessary, following

the instructions on page 1-4

You can’t use the flash when you adjust the shutter
speed manually with the camera connected to the
computer. Set the shutter speed to automatic to use the
flash.

You get an error message when you try to transfer your

pictures to the computer

0

Make sure the cable is connected correctly as described
on page 3-1.
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Make sure your camera is turned on and the batteries

have enough power.

Check the serial port settings in the Setup screen of
your EPSON Photo! software. You may need to change

the Port and Speed serial connection settings to Auto.

If the Speed is already set to Auto, you may need to
change the setting manually. Check the port settings in
the Windows Control panel to see if the EPSON Photo!
setting is too fast for your port. If it is, change the port
setting to a faster speed, if you can. If you can’t change
it to a faster speed, adjust the speed in your EPSON
Photo! software as described on page 3-6.

Make sure the port to which your camera is connected
is properly configured. The Base I/O port address and
the Interrupt Request Number (IRQ) assigned to the
port should not be in conflict with any other devices.

12-4 Caring for the Camera and Troubleshooting

Your LCD monitor has a flickering image

[J  Check to see what sort of lighting conditions you are
taking pictures under. If you are using View Mode of
the LCD monitor under fluorescent light, the monitor
may appear to flicker. This should not affect the
appearance of your photos.

Your LCD monitor shuts itself off and the battery icon

indicates that the batteries are used up.

O If you are using alkaline batteries, you may want to
consider switching to rechargeable or lithium batteries
when using the LCD monitor. These batteries last
longer and work better with this option.

O If you are mostly using the LCD monitor in Playback
mode, or taking indoor pictures, you may want to use
the AC adapter. See Appendix A for instructions on
ordering and using the AC adapter.

Picture Problems
If you're not satisfied with the pictures you get from
PhotoPC 500, you may need to adjust some of the camera

settings. Read the suggestions below.



Your pictures display poor image quality on the screen or

when you print them out.

0

PhotoPC 500 captures images in 24-bit color (16.7
million colors). Your pictures will not display
maximum image quality if your monitor or
computer’s video controller don't support this color
depth. You may need to upgrade your system to

achieve the best possible image quality.

If your pictures look better on the screen than when
you print them out, you may need to upgrade your
printer. An EPSON Stylus™ color ink jet printer, for
example, produces high resolution, photo-quality
images.

You may have checked high-quality when you
exported or transferred your image. This feature
makes the image larger, but does not increase the
resolution. The printed picture may not look as good as

it appears on the screen.

Your picture is blurry or out of focus.

O

0

Make sure your subject is within the camera’s range.
You should be at least 2 feet (60 cm) away to take a
picture without the flash, and 1.5 feet (45 cm) to 10 feet
(3 m) away to take a picture with the flash.

When the optional PhotoPIX LCD Monitor is attached,
you can take a picture from as close as 8 inches (20 cm)

in Macro mode. See page 11-12 for information.

Make sure you hold the camera steady, and your
subject isn’'t moving.

If you want to photograph a moving subject, you can
increase the shutter speed while the camera is
connected to your computer. For information about

changing the shutter speed, see page 5-4.

Make sure your flash is not set to flash off.

Your picture is too dark (underexposed)

O

You may need to use the flash. Make sure the setting is
not flash off.

If you are using the flash, make sure your subject is
within the range of 1.5 feet (45 cm) to 10 feet (3 m).
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[J  Use EPSON PhotoPC 500 imaging software to adjust the People or animals in your picture appear to have red eyes.

picture’s brightness and contrast. [0 Make sure you set your flash to red-eye reduction

O If you're using the optional LCD monitor’s Macro mode mode when taking pictures of people or animals.

to take a close-up photo, make sure you provide . L
o . Part of your picture is missing.
adequate lighting for your subject. The camera’s

aperture is automatically adjusted to its smallest "} Make sure you're not blocking the lens with your

setting (F8) when in this mode. finger, hand strap, clothing, or other object.

Your picture is too light (overexposed) A horizontal or vertical red line appears on your picture.

[0 If you're using the forced flash setting, it may be too U Redlines are caused by glare. Avoid photographing

bright. Try setting the flash to Auto shiny surfaces that reflect excessive amounts of light
into your lens.

[J If you're facing a bright light source, you may need to

shoot your picture from a different angle. [0 In bright light, you may need to use an ND-filter to

. ) ) avoid glare. Try a 37 mm ND-4 camcorder filter.
[J If you're taking pictures in the snow or on the beach on

a sunny day, you may need to use an ND-filter. A 37 The wrong date and/or time are displayed on your

mm ND-4 camcorder filter should work. See page A-7 pictures.

for more information. 0 You need to connect the camera to your computer and
O Use PhotoPC 500 image editing software to adjust the reset the camera’s clock. See Chapter3 for instructions.

picture’s brightness as described on page 8-2. Whenever you change the batteries in your camera

you need to reset the clock.
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The colors in your picture don’t look right.

O

When you take pictures under certain artificial

lighting conditions, the colors may be slightly distorted.

You can use PhotoPC 500 image-editing software to

adjust the colors as described on page 8-3.

Your pictures don’t look as good as they used to.

0

Your camera’s lens may be dirty or dusty. Try cleaning

it by following the instructions on page 12-1.

The area captured in the picture is different from what

you saw in the camera.

O

You need to make sure you look straight through the
viewfinder and capture your subject in the yellow

frame.

If you are using the optional PhotoPIX LCD Monitor,
the picture looks different from the live preview. The
image captured is actually slightly larger than what

appears in the LCD screen.
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/]A \ Using Optional Accessories

I) hotoPC 500’s versatility allows you to use it with a
variety of options. You can add the PhotoPIX LCD
Monitor to play back and selectively erase your images.
You can increase the camera’s storage capacity by
installing a 2MB or 4MB PhotoSpan module. To help you

save battery power, you can use the AC adapter.

The accessories listed below should be available where
you bought your PhotoPC 500. You can also order them
from EPSON accessories at (800) 873-7766 (U.S. sales
only). In Canada, call (800) 922-8911.

Accessory Part Number
PhotoPix LCD Monitor A883051
2MB PhotoSpan Memory Module A882401
4MB PhotoSpan Memory Module A88241
PhotoPC 500 AC Adapter B867027

For wide-angle pictures and special effects, you can use any
standard 37 mm video camcorder lens or filter. See page

A-7 for recommendations and ordering information.
For studio photos, you can attach a tripod to your camera.
This chapter includes the following instructions:

Expanding your PhotoPC 500 memory
Installing the PhotoSpan memory modules
Using the AC adapter

Using optional lenses

Attaching a tripod

O o o o o od

Using a 9- to 25-pin serial adapter

For information on using the LCD Monitor, see Chapter 9.
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Expanding Your PhotoPC 500 Memory

PhotoPC 500 comes with 2MB of internal memory, which

holds 30 pictures at high resolution or 60 pictures at

standard resolution. You can increase the camera’s

capacity by installing a ZMB or 4MB PhotoSpan external
memory module (flash memory board), as described in the

table below.

PhotoPC 500 Capacity

CAUTION

PhotoSpan modules are sensitive to static electricity and easily
damaged. Be sure you ground yourself by touching a metal object
before you handle the module, and never touch the module’s

metallic area.

Number of Photos 2 MB With 2MB With 4 MB
internal PhotoSpan PhotoSpan
memory A882401 A882411

At high resolution 30 65 100

At low resolution 60 130 200

Installing PhotoSpan Memory Modules
Before you install a PhotoSpan memory module, make sure

you erase all the pictures in the camera and turn it off.

A-2 Using Optional Accessories

Follow these steps to install a PhotoSpan module:

T Slide the memory module cover lock down to release

the cover.




4 Press down on the module until it snaps into the

2 Grasp the cover and pull away as shown:

retaining clips at the side of the socket.

3 Place the module into the socket as shown.

5 Replace the cover on the camera body until it snaps

memory

into place.
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6  Slide the lock up to lock the cover.

When you take your next picture, the pictures remaining
number on the control panel shows your camera’s

expanded capacity.

With the expanded memory, you may notice a delay
between the time you press the shutter button and when
the camera beeps. You can reduce this delay by pressing
the button down halfway, holding it until you're ready to

take the picture, and then pressing it down the rest of way.

A-4 Using Optional Accessories

Removing the Memory Module

If you want to remove a memory module for any reason
(such as upgrading from a 2MB to a 4MB module), follow
these steps:

CAUTION
Do not remove and install the module repeatedly. Doing so may

cause a bad connection or may damage the memory module.

T Turn the camera off, then remove the memory module

cover as described on page A-2



2 Press the lever on the side of the memory module Using the AC Adapter

socket to raise the module slightly out of the socket. The AC adapter (B867027) allows you to connect your
= PhotoPC 500 to any standard electrical outlet. This is
especially useful when you are transferring pictures and
operating the camera from your computer. The adapter

powers the cameraq, but does not charge the batteries.

WARNING
0  Use only the adapter designed for PhotoPC 500. Using any
other adapter may cause fire, electrical shock, or injury.

0 Do not alter the plug on the power cable, and do not use the

adapter for any other purpose than powering your

3 Grasp the edges of the memory module and work it up PhotoPC 500.

and out of the socket. Be careful not to touch the metal
parts of the module. To avoid losing any images or settings, make sure the
camera is finished processing before you connect or
4  Replace the memory module cover. p 9 y
disconnect the AC adapter. Then follow these steps:
T Locate the port cover on the side of the camera. Press

on the arrows and slide the cover to open it.
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2 Plug the adapter cable into the DC port on the camera. Using the AC adapter with the LCD Monitor

attached
If you are using the optional LCD Monitor and you want to

connect the AC adapter to your camera, follow these steps:

1  Tilt the LCD Monitor away from the camera as shown:

3 Connect the end of the power cable to an electrical

outlet

2 TFollow the steps on page A-5 to connect the AC adapter

to the camera.
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Using Optional Lenses

Although you can use any standard 37mm video
camcorder lens or filter with PhotoPC 500, lenses
manufactured by Tiffen are recommended. Call DC Pro at
(800) 522-7835 for ordering information.

To attach a lens, screw it onto the camera as shown below.

When you use a close-up lens, the viewfinder does not give
you an accurate preview of your picture. The best way to
take pictures is by using the optional LCD Monitor, as
described in Chapter 9, or by connecting the camera to

your computer as described in Chapter 3.

Attaching PhotoPC 500 to a Tripod

You can use your PhotoPC 500 digital camera with any

standard tripod.

Follow these steps:

1

Assemble and set up the tripod following the

manufacturer’s instructions.
Make sure the tripod is well balanced on a flat surface.

Find the opening for the tripod screw on the bottom of

your camera.

Carefully place the PhotoPC 500 on the tripod, and

screw the camera on until it is firmly in place.

Follow the manufacturer’s instructions to adjust the

tripod to view your subject.
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Using a 9 to 25 Pin Serial Adapter

If you only have a 25-pin serial port available, you can use

a 9 to 25 pin adapter for your serial cable.

NOTE
If you have both a 9-pin port and a 25-pin port free, you should use

the 9-pin port to prevent possible communication problems.

Follow these steps to connect a 25-pin adapter to your serial

cable:

1 Connect the serial cable to the smaller end of the

adapter as shown:

2 Tighten the screws.

A-8 Using Optional Accessories

Locate the 25-pin serial port on your computer and
follow the steps on page 3-1 to connect to your
computer, using your 25-pin port instead of a 9-pin

port.



E\ Specifications

Camera

Physical Dimensions

Width 5.59in (142 mm)
Height 319 in (81 mm)
Depth 2.09 in (53 mm)

Weight (without  0.66 lbs (300 g)
batteries)

Power
Sources

Consumption

Battery Life

4 AA batteries (single-use alkaline or
lithium or rechargeable Ni-Cad or
NiMH)

Optional AC adapter (B867027)

Approximately 100 mW at power-on

Approximately 4 W during image
processing

Maximum 12 W during flash discharge

Approximately 300 pictures (high
resolution) can be taken before the
batteries run out. (with new alkaline
batteries, 150 flashed and 150 non-
flashed pictures, without the optional
LCD Monitor attached)
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Technical
Product Type

Image size

Bit depth

Serial interface

Internal memory

Optional expansion
memory

Environmental
Temperature

Humidity

B-2 Specifications

CCD (charged coupled device)
still frame camera

640 x 480 pixels (high resolution)
320 x 240 pixels (standard resolution)

16 million colors, 24-bit

8-pin DIN (camera)
RS-232C, communication speed: 19,200
bps or higher (PC)

2MB flash memory

2MB (0.5MB flash memory x 4 chips)
4MB (0.5MB flash memory x 8 chips)

Operating 32 ° to 104 ° F (0 to 40 ° C)
Non-operating -4 ° to 140 ° F (-20 to 60 ° C)

Operating 30 to 90%
(non-condensing)
Non-operating 10 to 90%
(non-condensing)

Photographic

Lens
Range
Exposure
Shutter

Viewfinder
Aperture

Flash modes

Flash range

f =6 mm (equivalent to a 43 mm lens on
a 35 mm camera)

2 feet (60 cm) to infinity

8 inches (20 cm) to infinity (Macro mode
with optional PhotoPIX LCD Monitor)
Equivalent to ISO 130

Automatic electronic shutter, 1/30 to
1/10,000 second

Optical
F2.8/8 automatic change

forced flash, automatic, red-eye
reduction, flash off

1.5t0 10 ft (0.45 to 3 m)



Optional LCD Monitor

Physical Dimensions

Width
Height
Depth

Weight

Power
Source

Consumption

Technical
LCD Panel

Display resolution

508 in (129 mm)
272 in (69 mm)
197 in (50 mm)

0311b (141 g)

Supplied from camera

1.8 in, TFT color LCD

279 x 220 pixels

Optional AC Adapter

Physical Dimensions
1.97 in (50 mm)

Width

Height

Depth

Power
Output

Input

118 in (30 mm)
1.85 in (47 mm) including pins

374 in (90 mm)

DC7V/20A

110 to 120 V AC, 50 - 60 Hz
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